
GroupWise
Interoperability Guide

April 2024



Legal Notices
Copyright 1993 - 2024 Open Text.

The only warranties for products and services of Open Text and its affiliates and licensors (“Open Text”) are as may be set 
forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. Open Text shall not be liable for technical or editorial errors or omissions contained 
herein. The information contained herein is subject to change without notice.
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About This Guide

This GroupWise Interoperability Guide helps you use GroupWise in the context of other software 
products.

The following resources provide additional information about using GroupWise:

 OpenText Support and Knowledge Base

To search the GroupWise documentation from the OpenText Support website, click Advanced 
Search, select Documentation in the Search In drop-down list, select GroupWise in the Products 
drop-down list, type the search string, and then click Search.

 GroupWise Support Community

Audience
This guide is intended for network administrators who install and administer GroupWise.

Feedback
We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation.

Additional Documentation
For additional GroupWise documentation, see the GroupWise Documentation website.
About This Guide 7
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I ISetting up a GroupWise Cluster

Setting up your GroupWise system using a server cluster is the preferred method for providing high 
availability access to your GroupWise clients by ensuring you have failover redundancy and load 
balancing of available server assets. GroupWise uses OES Cluster Services (NCS) for clustering.

Your cluster needs to be set up before you create a GroupWise system, so you can configure 
GroupWise administration and agents to use the cluster as you install GroupWise. Before you begin 
with the instructions contained in the sections below, review the content in “Overview of OES 
Cluster Services” in the OES Cluster Services for Linux Administration Guide.

 Chapter 1, “OES Cluster Services (NCS) on Linux,” on page 11
 Chapter 2, “Using Windows Server Failover Clustering with GroupWise,” on page 49
Setting up a GroupWise Cluster 9
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1 1OES Cluster Services (NCS) on Linux

These sections provide information for how to set up your GroupWise system using OES Cluster 
Services on Linux.

 “Introduction to GroupWise and OES Cluster Services on Linux” on page 11
 “Planning GroupWise in a Linux Cluster” on page 12
 “Creating a New GroupWise System to Work with OES Cluster Services” on page 21
 “Upgrading a Clustered Linux GroupWise System to GroupWise 18” on page 29
 “Implementing the Document Viewer Agent in a Linux Cluster” on page 34
 “Implementing the Internet Agent in a Linux Cluster” on page 34
 “Implementing the GroupWise Web Applications in a Cluster” on page 46
 “Upgrading a GroupWise System in a Linux Cluster” on page 46
 “Moving an Existing Linux GroupWise System into a Linux Cluster” on page 47

Introduction to GroupWise and OES Cluster Services on 
Linux

Before implementing GroupWise with OES Cluster Services on Linux, make sure you have a solid 
understanding of OES Cluster Services by reviewing the OES Linux Clustering documentation for your 
version of Open Enterprise Server (OES) on Linux. When you review this information, you discover 
that clustering employs very specialized terminology. The following brief glossary provides basic 
definitions of clustering terms and relates them to your GroupWise system:

cluster: A grouping of from two to 32 servers configured using OES Cluster Services so that data 
storage locations and applications can transfer from one server to another without interrupting their 
availability to users.

node: A clustered server; in other words, a single server that is part of a cluster.

shared disk system: The hardware housing the physical disks that are shared among the cluster 
nodes.

shared partition: A disk partition in a shared disk system that can be accessed from any cluster node 
that needs the data stored on it. On Linux, OES Cluster Services supports shared partitions (Linux 
traditional file system disk partitions), shared NSS volumes (Novell Storage Services volumes), and 
shared pools (virtual servers).

NOTE: For simplicity, this section uses the term “shared partition” to represent any of these three 
storage configuration alternatives. For more information, see the OES Cluster Services for Linux 
Administration Guide for your version of OES Linux.
OES Cluster Services (NCS) on Linux 11

https://www.microfocus.com/documentation/open-enterprise-server/2023/
https://www.microfocus.com/documentation/open-enterprise-server/2023/
https://www.microfocus.com/documentation/open-enterprise-server/2023/


cluster-enabled shared partition: A shared partition for which a Cluster Resource object has been 
created in NetIQ eDirectory. The properties of the Cluster Resource object provide load and unload 
scripts for applications and services installed on the partition, failover/failback/migration policies for 
the applications and services, and the failover list for the partition.

IMPORTANT: Cluster-enabling is required for GroupWise. For more information, see the OES Cluster 
Services for Linux Administration Guide for your version of OES Linux.

GroupWise partition: As used in this section, a cluster-enabled shared partition that is used for 
GroupWise, such as for housing a domain, a post office, or a software distribution directory.

Messenger partition: As used in this section, a cluster-enabled shared partition that is used for 
Messenger, such as for storing conversation files, log files, temporary files, queue directories, and so 
on.

cluster resource: A shared partition, secondary IP address, application, service, Web server, and so 
on, that can function successfully anywhere in the cluster. Cluster resources include the GroupWise 
agents and the Messenger agents.

failover: The process of moving cluster resources from a failed node to a functional node so that 
availability to users is uninterrupted. For example, if the node where the POA is running goes down, 
the POA and its post office fail-over to a secondary node so that users can continue to use 
GroupWise. When you set up cluster resources, you must consider what components need to fail-
over together in order to continue functioning.

fan-out-failover: The configuration where cluster resources from a single failed node fail-over to 
several different nodes in order to distribute the load from the failed node across multiple nodes. 
For example, if a node runs a cluster resource consisting of a domain and its MTA, another cluster 
resource consisting of a post office and its POA, and a third cluster resource for the GWIA, each 
cluster resource can be configured to fail-over separately to different secondary nodes.

failback: The process of returning cluster resources to their preferred node after the situation 
causing the failover has been resolved. For example, if a POA and its post office fail-over to a 
secondary node, that cluster resource can be configured to fail back to its preferred node when the 
problem is resolved.

migration: The process of manually moving a cluster resource from its preferred node to a 
secondary node for the purpose of performing maintenance on the preferred node, temporarily 
lightening the load on the preferred node, and so on.

Planning GroupWise in a Linux Cluster
The majority of this part of the GroupWise Interoperability Guide (Planning GroupWise in a Linux 
Cluster through Implementing the GroupWise Web Applications in a Cluster) is designed for those 
who are creating a new GroupWise system, or at least new domains and post offices, in the context 
of OES Cluster Services (NCS) on Linux.

If you already have an existing GroupWise system on OES Linux and need to configure it to work in a 
newly installed cluster, see Moving an Existing Linux GroupWise System into a Linux Cluster.
12 OES Cluster Services (NCS) on Linux
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When you implement a new GroupWise system or a new domain or post office in a clustering 
environment, overall GroupWise system design does not need to change substantially. For a review, 
see “Planning Your GroupWise System” in the GroupWise Installation Guide. However, the 
configuration of individual components of your GroupWise system will be significantly different. This 
section helps you plan the following GroupWise components in a cluster:

 A new GroupWise system consisting of the primary domain and the initial post office
 A new secondary domain
 A new post office
 The GroupWise agents: Message Transfer Agent (MTA), Post Office Agent (POA), and Document 

Viewer Agent (DVA)

During the planning process, component configuration alternatives are explained. For example, you 
might want the domain and post office together on the same shared partition or on different shared 
partitions.

The System Clustering Worksheet and the Agent Clustering Worksheet list the information you need 
as you set up GroupWise in a clustering environment. You should print these worksheets and fill 
them out as you complete the tasks listed below:

 “Installing OES Cluster Services (NCS) on Linux” on page 13
 “Planning a New Clustered Domain” on page 15
 “Planning a New Clustered Post Office” on page 16
 “Planning a New Library for a Clustered Post Office” on page 16
 “Configuring the Linux Agents in a Cluster” on page 17
 “GroupWise Clustering Worksheets” on page 19

After you have completed the tasks and filled out the System Clustering Worksheet and the Agent 
Clustering Worksheet, you are ready to continue with Installing OES Cluster Services (NCS) on Linux.

Installing OES Cluster Services (NCS) on Linux
Install OES Cluster Services (NCS) on OES Linux by following the instructions provided in the OES 
Cluster Services for Linux Administration Guide for your version of OES Linux.

The cluster installation process includes:

 Meeting hardware and software requirements
 Setting up a shared disk system
 Creating a new Cluster object to represent the cluster in NetIQ eDirectory
 Adding nodes to the cluster
 Installing the OES Cluster Services software on all nodes in the cluster
 Creating shared partitions, shared NSS volumes, or shared pools as needed for your cluster, as 

described in the OES Cluster Services for Linux Administration Guide for your version of OES 
Linux.

NOTE: For simplicity in this section, the term “shared partition” is intended to include any of 
these shared storage alternatives.
OES Cluster Services (NCS) on Linux 13
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 Cluster-enabling any of these shared storage alternatives, as described in the OES Cluster 
Services for Linux Administration Guide for your version of OES Linux.

IMPORTANT: Cluster-enabling is required for GroupWise.

 Mounting the shared partitions where you want to set up GroupWise domains and post offices.

As you install OES Cluster Services on Linux, record key information about the cluster on the System 
Clustering Worksheet:

The number of nodes and shared partitions that are available in the cluster strongly influences 
where you can place GroupWise domains and post offices. You have several alternatives:

 Your whole GroupWise system can run in a single cluster.
 Parts of your GroupWise system can run in one cluster while other parts of it run in one or more 

other clusters.
 Parts of your GroupWise system can run in a cluster while other parts run outside of the cluster, 

on non-clustered servers.

If you do not have the system resources to run all of your GroupWise system in a clustering 
environment, you must decide which parts have the most urgent need for the high availability 
provided by clustering. Here are some suggestions:

 Post offices and their POAs must be available in order for users to access their GroupWise 
mailboxes. Therefore, post offices and their POAs are excellent candidates for the high 
availability provided by clustering.

 Domains and their MTAs are less noticeable to users when they are unavailable (unless users in 
different post offices happen to be actively engaged in an email discussion when the MTA goes 
down). On the other hand, domains and their MTAs are critical to GroupWise administrators, 
although administrators might be more tolerant of a down server than end users are. Critical 
domains in your system are the primary domain and, if you have one, a hub or routing domain. 
These domains should be in the cluster, even if other domains are not.

SYSTEM CLUSTERING WORKSHEET

Under Item 1: eDirectory Tree for Cluster, record the name of the eDirectory tree where the new Cluster 
object has been created.

Under Item 2: Cluster Name, record the name of the Cluster object that you created for your GroupWise 
system.

Under Item 3: Cluster Context, record the full context of the Cluster object.

Under Item 4: Nodes in Cluster, list the nodes that you have added to the cluster. Include the file system 
information about each partition, including file system type (nss, reiserfs, ext3, and so on), device 
name (sda2, hda1, and so on), and mount point directory (/media/nss, /mnt, /mail, and so on). You 
need this information when you set up the load and unload scripts for the GroupWise cluster resources.

Under Item 5: Shared Partitions, list the volume names and volume IDs for the shared partitions that are 
available for use in your GroupWise system. You need this information when you set up the load and unload 
scripts for the GroupWise cluster resources.
14 OES Cluster Services (NCS) on Linux

https://www.microfocus.com/documentation/open-enterprise-server/2023/


 The GWIA might or might not require high availability in your GroupWise system, depending on 
the importance of immediate messaging across the Internet and the use of POP3 or IMAP4 
clients by GroupWise users.

 The Monitor Agent is a vital partner with the GroupWise High Availability service, described in 
“Installing the GroupWise Monitor Software” in the GroupWise Installation Guide. The 
GroupWise High Availability service automatically restarts agents that go down under 
circumstances that do not cause the entire server to go down. If you want this protection for 
your GroupWise agents, you can run the Monitor Agent in your cluster.
See also, “Monitor and the GroupWise High Availability Service on Linux” in the GroupWise 
Installation Guide.

There is no right or wrong way to implement GroupWise in a clustering environment. It all depends 
on the specific needs of your particular GroupWise system and its users.

Planning a New Clustered Domain
The considerations involved in planning a new domain in a clustering environment are essentially 
the same as for any other environment.

 Primary Domain: If you are setting up a new GroupWise system in a clustering environment, 
you are creating the primary domain as you complete the tasks in this section. To prepare, 
review “Planning Your GroupWise System” and “Installing the GroupWise Server Software” in 
the GroupWise Installation Guide, which includes links to the Simple GroupWise System 
Worksheet and the Primary Domain Worksheet. These cover planning the primary domain and 
an initial post office in the primary domain.

 Secondary Domain: If your GroupWise system already exists, you are creating a new secondary 
domain. To prepare, review “Creating a New Domain” in the GroupWise Administration Guide, 
which includes a link to the Secondary Domain Worksheet.

Regardless of the type of domain you are creating, keep in mind the following cluster-specific details 
as you fill out the worksheet you need:

 When you specify the location for the domain directory (and for a new GroupWise system, the 
post office directory) on the worksheet, remember that it will be on a GroupWise partition, not 
on the node where you will be running the GroupWise Installation program.

IMPORTANT: Configuring a domain or post office directly at the root of a cluster volume is not 
supported. An example of a root path on an NSS volume is /media/nss/GW. In this example, 
you need a sub-directory under GW when configuring your domain in order to avoid issues with 
GroupWise certificates. 

A working example can be found in the Sample Cluster Load Script where DOM is the volume 
root with a sub-directory of utah.

 Do not concern yourself with the GroupWise agent information on the worksheet. You will plan 
the agent installation later.

When you have completed the worksheet, transfer the key information from the “Primary Domain 
Worksheet”or the “Secondary Domain Worksheet”in the GroupWise Installation Guide to the 
System Clustering Worksheet.
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IMPORTANT: Do not create the new domain until you are instructed to do so in Creating a New 
GroupWise System to Work with OES Cluster Services.

Planning a New Clustered Post Office
The considerations involved in planning a new post office in a clustering environment are essentially 
the same as for any other environment. The initial post office in a new GroupWise system on Linux is 
planned on the Post Office Worksheet. To plan additional new post offices, review “Creating a New 
Post Office” in the GroupWise Administration Guide, which includes a link to the Post Office 
Worksheet. When you specify the location for the post office directory, remember that it will be on a 
GroupWise partition, not on the node where you will be running the GroupWise Installation 
program.

When you have completed the worksheet, transfer key information from the Post Office Worksheet 
to the System Clustering Worksheet.

IMPORTANT: Do not create the new post office until you are instructed to do so in Creating a New 
GroupWise System to Work with OES Cluster Services.

Planning a New Library for a Clustered Post Office
The considerations involved in planning a new library in a clustering environment are essentially the 
same as for any other environment. However, in a Linux cluster, you should not plan to locate a 
document storage area on a remote storage area. If you choose to place it outside the post office 
directory structure, it should still be located on the same server with the post office.

You can plan a library for a clustered post office by following the standard instructions provided in 
“Creating and Managing Libraries” in the GroupWise Administration Guide and filling out the 
“Library Worksheet”. Then provide the library information on the System Clustering Worksheet.

SYSTEM CLUSTERING WORKSHEET

Under Item 9: Domain Name, transfer the domain name and database directory to the System Clustering 
Worksheet.

Under Item 7: GroupWise Partition for Domain, transfer the domain location to the System Clustering 
Worksheet. Also specify the secondary IP address of the shared partition where you plan to create the 
domain.

SYSTEM CLUSTERING WORKSHEET

Under Item 10: Post Office Name, transfer the post office name and database location to the System 
Clustering Worksheet. Also specify the secondary IP address of the shared partition where you plan to create 
the domain.

If you will create the post office on a different GroupWise partition from where the domain is located, under 
Item 8: Shared Partition for Post Office, transfer the post office location to the System Clustering Worksheet. 
Also specify the secondary IP address of the shared partition where you plan to create the post office.
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IMPORTANT: Do not create the new library until you are instructed to do so in Creating a New 
GroupWise System to Work with OES Cluster Services.

Configuring the Linux Agents in a Cluster
There are several cluster-specific issues to consider as you plan to configure the Linux MTA, POA, and 
DVA in your clustered GroupWise system:

 “Recording Secondary IP Addresses for the Linux Agents” on page 17
 “Determining Appropriate Failover Lists for the Linux Agents” on page 18
 “Determining Cluster Resource Information for the Linux Agents” on page 18
 “Planning for Linux GroupWise Agents” on page 18

Recording Secondary IP Addresses for the Linux Agents
By default, the GroupWise agents listen on all IP addresses, both primary and secondary, that are 
bound to the server. This means that any time there is a possibility of two of the same type of agents 
loading on the same node, it is important that each agent use the appropriate secondary IP address 
of the GroupWise partition. The secondary IP address moves with each agent when it fails-over, so 
that, in the case of the POA, GroupWise clients do not lose their connections to the POA.

If you are planning to set up a GroupWise name server to help GroupWise clients locate their post 
offices, make sure that the default POA port number of 1677 is used somewhere in the cluster. For 
more information, see “Simplifying Client Access with a GroupWise Name Server” in the GroupWise 
Administration Guide.

Clustering is not necessary in order to provide high availability for the DVA. As an alternative to 
clustering, you can install the DVA on multiple servers outside the cluster, as described in “Scaling 
Your DVA Installation” in the GroupWise Administration Guide.

SYSTEM CLUSTERING WORKSHEET

Under Item 11: Document Storage Area Location, mark where you want to create the library’s document 
storage area.

AGENT CLUSTERING WORKSHEET

Under Item 3: MTA Network Information, transfer the domain secondary IP address from the System 
Clustering Worksheet to the Agent Clustering Worksheet.

Under Item 6: POA Network Information, transfer the post office secondary IP address from the System 
Clustering Worksheet to the Agent Clustering Worksheet.

Under Item 7: DVA Network Information, transfer the post office secondary IP address from the System 
Clustering Worksheet to the Agent Clustering Worksheet.
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Determining Appropriate Failover Lists for the Linux Agents
By default, a GroupWise partition is configured to have all nodes in the cluster in its failover list, 
organized in ascending alphanumeric order. Only one node at a time can have a particular 
GroupWise partition mounted and active. If a GroupWise partition’s preferred node fails, the 
partition fails-over to the next node in the failover list. You should customize the failover list for each 
GroupWise partition based on the fan-out-failover principle.

When a node fails, its partitions should not all fail-over together to the same secondary node. 
Instead, the partitions should be distributed across multiple nodes in the cluster. This prevents any 
one node from shouldering the entire processing load typically carried by another node. In addition, 
some partitions should never have the potential of being mounted on the same node during a 
failover situation. For example, a post office and POA that service a large number of very active 
GroupWise client users should never fail-over to a node where another very large post office and 
heavily loaded POA reside. If they did, users on both post offices would notice a decrease in 
responsiveness of the GroupWise client.

Determining Cluster Resource Information for the Linux Agents
A cluster resource is a shared partition, secondary IP address, application, service, Web server, and 
so on, that can function successfully anywhere in the cluster. Cluster resources include the 
GroupWise agents and the Messenger agents. For example, you might create a /mnt/gwsystem 
mount point, or you might create /mnt/dom1 and /mnt/po1 mount points.

Planning for Linux GroupWise Agents
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning for the GroupWise Linux agents are the same in a clustering environment as for 
any other environment. Review “Working with the GroupWise Agents” and “Linux: Managing the 
GroupWise Agents” in the GroupWise Installation Guide.

IMPORTANT: Do not install the Linux agent software until you are instructed to do so in Creating a 
New GroupWise System to Work with OES Cluster Services.

AGENT CLUSTERING WORKSHEET

Under Item 2: Domain Failover List, list the nodes that you want to have in the domain partition failover list. 
The MTA might need to run on any node that the domain partition fails over to. Therefore, you will install the 
agent software on all of the nodes in the domain failover list.

If you are planning the post office on a different GroupWise partition from where the domain is located, 
under Item 5: Post Office Failover List, list the nodes that you want to have in the post office partition failover 
list. The POA (and the DVA if you installed along with the POA) might need to run on any node that the post 
office partition fails over to. Therefore, you will install the agent software on all of the nodes in the post 
office failover list.

AGENT CLUSTERING WORKSHEET

Under Item 8: Cluster Resource Information, list the mount point and secondary IP address for the 
GroupWise partition where the domain and post office will be located.
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GroupWise Clustering Worksheets
 “System Clustering Worksheet” on page 19
 “Agent Clustering Worksheet” on page 20

System Clustering Worksheet

Item Explanation

1) eDirectory Tree for Cluster: Record the eDirectory tree where you created the 
new Cluster object when you installed OES Cluster 
Services for Linux.

For more information, see Installing OES Cluster 
Services (NCS) on Linux

2) Cluster Name:

Master IP Address:

Record the name of the new Cluster object that you 
created for your GroupWise system. Also record the 
virtual IP address of the cluster that will remain 
constant regardless of which node is currently 
active.

For more information, see Installing OES Cluster 
Services (NCS) on Linux.

3) Cluster Context: Record the full context where you created the new 
Cluster object.

For more information, see Installing OES Cluster 
Services (NCS) on Linux.

4) Nodes in Cluster:

 File system type
 Device name
 Mount point directory

List the nodes that are part of the cluster that you 
set up for your GroupWise system. Also list the file 
system type (reiserfs, ext3, and so on), device 
name (sda2, hda1, and so on), and mount point 
directory (/mnt, /mail, and so on) for each. You 
need this information as you create load and unload 
scripts for GroupWise agents.

For more information, see Installing OES Cluster 
Services (NCS) on Linux.

5) Shared Partitions in Cluster:

 Volume name
 Volume ID

List the volume name and volume ID for each 
shared partition that is available for use in your 
GroupWise system.

For more information, see Installing OES Cluster 
Services (NCS) on Linux.

6) GroupWise Partition for 
Software Distribution Directory:

Secondary IP Address:

Directory:

If desired, specify the name of the shared partition 
where the GroupWise software distribution 
directory will reside and the full path to its location.

For more information, see Introduction to 
GroupWise and OES Cluster Services on Linux.
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Agent Clustering Worksheet

7) GroupWise Partition for 
Domain:

Secondary IP Address:

Post Office on Same Partition as 
Domain?

 Yes
 No

Specify the name of the shared partition where the 
GroupWise domain will reside and its secondary IP 
address.

For more information, see Planning a New Clustered 
Domain.

8) GroupWise Partition for Post 
Office:

Secondary IP Address:

Specify the name of the shared partition where the 
GroupWise post office will reside and its secondary 
IP address.

For more information, see Planning a New Clustered 
Post Office.

9) Domain Name:

Domain Directory:

Specify a unique name for the domain. Specify the 
directory on the GroupWise partition where you 
want to create the new domain.

For more information, see Planning a New Clustered 
Domain.

10) Post Office Name:

Post Office Directory:

Specify a unique name for the post office. Specify 
the directory on the GroupWise partition where 
you want to create the post office.

For more information, see Planning a New Clustered 
Post Office.

11) Document Storage Area 
Location:

 At the post office
 Outside the post office
 Separate post office

If you need a library for a clustered post office, mark 
where you want to create its document storage area 
and provide a directory if necessary.

For more information, see Planning a New Library 
for a Clustered Post Office.

Item Explanation

1) Domain Name:

Domain Location:

Transfer this information from the System Clustering 
Worksheet (item 9).

2) Domain Failover List: List other nodes in the cluster where the GroupWise 
domain and its MTA can fail-over.

For more information, see Determining Appropriate 
Failover Lists for the Linux Agents.

Item Explanation
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Creating a New GroupWise System to Work with OES 
Cluster Services

Before proceeding with the instructions in these sections to create a new GroupWise system with 
OES Cluster Services, you should already have reviewed the previous sections in OES Cluster Services 
(NCS) on Linux to set up your cluster on Linux. If your cluster is now ready for the GroupWise 
installation, reference the sections below to do so.

 “GroupWise Installation Wizard” on page 22
 “GroupWise Administration Console” on page 22

3) MTA Network Information:

 MTA IP address
 MTA message transfer port
 MTA HTTP port

Record the MTA network address information for 
the server where the MTA will run. The MTA IP 
address is the same as the domain secondary IP 
address in the cluster.

See Recording Secondary IP Addresses for the Linux 
Agents.

4) Post Office Name:

Post Office Location:

Transfer this information from the System Clustering 
Worksheet (item 10).

5) Post Office Failover List: List other nodes in the cluster where the GroupWise 
post office and its POA can fail-over.

For more information, see Determining Appropriate 
Failover Lists for the Linux Agents.

6) POA Network Information:

 POA IP address
 POA client/server port
 POA message transfer port
 POA HTTP port

Record the POA network address information for 
the server where the POA will run. The POA IP 
address is the same as the post office secondary IP 
address in the cluster.

See Recording Secondary IP Addresses for the Linux 
Agents.

7) DVA Network Information:

 DVA IP address
 DVA HTTP port

If you are configuring the DVA along with the POA so 
that it can participate in the cluster, record the DVA 
network address information for the server where 
the DVA will run. When you install the DVA along 
with the POA, the DVA IP address is the same as the 
post office secondary IP address in the cluster.

See Recording Secondary IP Addresses for the Linux 
Agents.

8) Cluster Resource Information

 Path to the cluster resource 
mount point

 IP address of the cluster 
resource

List the cluster resource information for the 
GroupWise partition where the domain and post 
office serviced by the agents are located.

For more information, see Determining Cluster 
Resource Information for the Linux Agents.

Item Explanation
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 “GroupWise Administration Service” on page 23
 “GroupWise Installation Console” on page 23
 “GroupWise Load and Unload Scripts” on page 24
 “GroupWise Cluster Test” on page 25
 “Creating a New Secondary Domain in a Linux Cluster” on page 26
 “Testing Your Clustered GroupWise System on Linux” on page 26
 “Managing Your Clustered GroupWise System on Linux” on page 27
 “What’s Next” on page 29
 “GroupWise System Quick Checklist” on page 29

GroupWise Installation Wizard
Install the GroupWise Server component on each cluster node where a GroupWise agent will run for 
a domain or a post office.

Follow the instructions in Step 1 through Step 9 in “Linux: Installing the GroupWise Server Software” 
in the GroupWise Installation Guide.

IMPORTANT: Install the GroupWise Server component on all cluster nodes before setting up any 
domains or post offices. Do not start the GroupWise Installation Console at the end of the 
installation process.

GroupWise Administration Console
For more information about using the GroupWise Administration Console, see the following 
references:

 GroupWise Installation Guide, “Working with the GroupWise Administration Console”
 GroupWise Administration Guide, “GroupWise Administration Console”
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GroupWise Administration Service
You must configure the GroupWise Administration Service to function in a cluster so that it keeps 
track of which cluster resources are available to it at each point in time. Configuring the GroupWise 
Administration Service for clustering ensures that files associated with domains and post offices are 
created on cluster volumes, rather than on individual cluster nodes.

On each cluster node:

1 Run the following command to enable the GroupWise Admin Service to run in a clustering 
environment:

gwadminutil config -cluster enable
You should receive the following response:

Cluster: enabled
Default Port: 9710

2 Use the following command to restart the GroupWise Admin Service.

rcgrpwise restart gwadminservice
Your GroupWise system is now ready to function in a cluster.

GroupWise Installation Console
In the Installation console, when you are creating domains and post offices in a cluster, a few fields 
require cluster-specific information.

 “Domain Fields” on page 24
 “Post Office Fields” on page 24

File Standard Location Clustered location

Domain SSL Certificate, 
MTA SSL Certificate, GWIA 
SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates
(a peer to the domain folder)

Post Office SSL Certificate, 
POA SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates
(a peer to the post office folder)

MTA Log Files /var/log/novell/groupwise/
domain.mta

/groupwise/agents/logs
(a peer to the domain folder)

GWIA Log Files /var/log/novell/groupwise/
gwia.domain

/groupwise/agents/logs
(a peer to the domain folder)

POA Log Files /var/log/novell/groupwise/
post_office.poa

/groupwise/agents/logs
(a peer to the post office folder)
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Domain Fields
When you follow the instructions in “Creating the Primary Domain” in the GroupWise Installation 
Guide, pay special attention to the following fields:

 In the Host field, specify the secondary IP address of the shared resource where you want to 
create the domain.

 In the Domain Folder field, specify a folder on the shared resource where you want to create the 
domain.

Post Office Fields
When you follow the instructions in Step 2 through Step 8 in “Adding a Post Office” in the 
GroupWise Installation Guide, pay special attention to the following fields:

 In the Owning Domain Host field, specify the secondary IP address of the shared resource where 
the owning domain is located.

 In the Owning Domain Admin Port field, specify the port on the shared resource for the domain.
 In the Host field, specify the secondary IP address of the shared resource where you want to 

create the post office.
 In the Post Office Folder field, specify a folder on the shared resource where you want to create 

the post office.

GroupWise Load and Unload Scripts
Samples of load and unload scripts are provided below.

 “Sample Cluster Load Script” on page 24
 “Sample Cluster Unload Script” on page 25

Sample Cluster Load Script
This sample cluster load script performs the following actions:

 Establishes what to do for certain error conditions.
 Creates the GroupWise agent services (if they do not already exist).
 Starts the GroupWise Admin Service listeners with clustering enabled for the MTA.
 Starts the MTA, POA, and GWIA (in that order, if all are present)

#!/bin/bash
./opt/novell/ncs/lib/ncsfuncs
exit_on_error nss /poolact=DOM
exit_on_error ncpcon mount DOM=254
exit_on_error add_secondary_ipaddress 151.155.136.248
exit_on_error ncpcon bind --ncpservername=DOM --ipaddress=151.155.136.248
exit_on_error novcifs --add '--
vserver=".cn=DOM.ou=servers.o=novell.t=GW14-TREE."'

--ip-addr=151.155.136.248
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# Start gwadmin service
exit_on_error /etc/init.d/grpwise start gwadminservice
#create agent services
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/utah
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/utah/
wpgate/gwia
exit_on_error /opt/novell/groupwise/admin/gwadminutil services

-i /media/nss/DOM/provo/
#start admin service listeners
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start utah cluster
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start provo.utah
cluster 
#start GroupWise agents
exit_on_error /etc/init.d/grpwise start utah
exit_on_error /etc/init.d/grpwise start gwia.utah
exit_on_error /etc/init.d/grpwise start provo.utah
exit 0

Sample Cluster Unload Script
This sample cluster unload script performs the following actions:

 Stops the GroupWise Admin Service listeners for the MTA and POA
 Stops the MTA, GWIA, and POA (in that order if all are present)
 Lists error conditions that can be ignored

#!/bin/bash
. /opt/novell/ncs/lib/ncsfuncs
# Stop admin service listeners
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop utah
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop provo.utah
# Stop GroupWise agents
ignore_error /etc/init.d/grpwise stop utah
ignore_error /etc/init.d/grpwise stop gwia.utah
ignore_error /etc/init.d/grpwise stop provo.utah
ignore_error novcifs 

--remove '--vserver=".cn=DOM.ou=servers.o=novell.t=GW14-
TREE."' 

--ip-addr=151.155.136.248
ignore_error ncpcon unbind --ncpservername=DOM --ipaddress=151.155.136.248
ignore_error del_secondary_ipaddress 151.155.136.248
ignore_error nss /pooldeact=DOM
exit 0

GroupWise Cluster Test
Follow the instructions in Testing Your Clustered GroupWise System on Linux to verify that the 
GroupWise Admin console keeps track of the cluster resources that are currently available to it.
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Creating a New Secondary Domain in a Linux Cluster
After you have set up the primary domain and initial post office, as described in Creating a New 
GroupWise System to Work with OES Cluster Services, you can create additional secondary domains 
in your GroupWise system as needed.

To create a new secondary domain in a clustering environment:

1 Mount the GroupWise partition where the new secondary domain will be created.
2 Connect to the primary domain in your GroupWise system. For information see, “Connecting to 

a Domain” in the GroupWise Administration Guide.
3 Create the new domain, following the steps provided in “Creating a New Domain” in the 

GroupWise Administration Guide.
Use the Domain Worksheet you filled out in Planning a New Clustered Domain to fill in the fields 
in the New Domain dialog box.

4 In the Link to Domain field, link the new domain to the primary domain of your GroupWise 
system.

5 Use the Link Configuration tool to change the links from the new domain to all other domains in 
the cluster to direct TCP/IP links. For information, see “Managing the Links between Domains 
and Post Offices” in the GroupWise Administration Guide.
Although a complete mesh link configuration is the most efficient, it might not be feasible in all 
situations. Set up as many direct TCP/IP links as possible for best MTA performance in the 
cluster.

6 Make sure you are still connected to the primary domain.
7 Rebuild the domain database for the new domain, following the steps provided in “Rebuilding 

Domain or Post Office Databases” in the GroupWise Administration Guide.
The database rebuild is necessary in order to transfer the MTA configuration information and 
the domain link information into the secondary domain database, because the MTA for the new 
domain is not yet running.

Testing Your Clustered GroupWise System on Linux
After you have configured the GroupWise cluster resources, you can test the load and unload scripts 
by bringing the GroupWise cluster resource online and taking it offline again.

1 In iManager, expand Clusters, and then click Cluster Manager.
2 Browse to the Cluster object to display the current cluster state.
3 (Conditional) If the new GroupWise cluster resource shows Offline in the State column, select 

the new GroupWise cluster resource, and then click Online.
After a moment, the GroupWise cluster resource displays Running in the State column.

4 At the server where the MTA and/or POA are starting, use the following command to see if they 
are running:

rcgrpwise status domain
rcgrpwise status post_office.domain

5 Select the new GroupWise cluster resource, and then click Offline.
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The State column for the GroupWise cluster resource displays Offline.
6 Use the same command you used in Step 4 to verify if they have stopped.
7 Repeat Step 3 whenever you are ready to bring the new GroupWise cluster resource online 

permanently.
8 Continue with Managing Your Clustered GroupWise System on Linux.

Managing Your Clustered GroupWise System on Linux
After you have set up a basic clustered GroupWise system, you should consider some long-term 
management issues.

 “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 27
 “Knowing What to Expect in MTA, POA, and DVA Failover Situations” on page 28

Updating GroupWise Objects with Cluster-Specific Descriptions
After setting up your clustered GroupWise system, while the cluster-specific information is fresh in 
your mind, you should record the cluster-specific information as part of the GroupWise objects in 
the GroupWise Administration Console so that you can easily refer to it later. Be sure to update the 
information in the GroupWise objects if the configuration of your system changes.

 “Recording Cluster-Specific Information for a Domain and Its MTA” on page 27
 “Recording Cluster-Specific Information for a Post Office and Its POA” on page 28

Recording Cluster-Specific Information for a Domain and Its MTA
To permanently record important cluster-specific information for the domain:

1 Browse to and click the Domain object in the Administration Console.
2 In the Description field of the General tab, provide a cluster-specific description of the domain, 

including the secondary IP address of its GroupWise partition.
3 Click Save to save the domain description.
4 Select the Objects tab > Message Transfer Agents, and click the MTA object.
5 In the Description field of the MTA General tab, record the secondary IP address of the domain’s 

GroupWise partition.
This information appears on the MTA server console, no matter which node in the cluster it is 
currently running on.

6 Click Save to apply the changes.
7 Select the Agents Settings tab of the MTA object.
8 In the Host Name field under Network Address, provide the host name address that you 

provided in the GroupWise Installation program.
9 Select Bind Exclusively to Host Name.

This records this vital information in eDirectory as well as in the MTA startup file.
10 Click Save to save the MTA description and host name address.
11 Continue with Recording Cluster-Specific Information for a Post Office and Its POA.
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Recording Cluster-Specific Information for a Post Office and Its POA
To permanently record important cluster-specific information for a post office:

1 Browse to and click the Post Office object in the Administration Console.
2 In the Description field of the General tab:

2a Provide a cluster-specific description of the post office, including the secondary IP address 
of its GroupWise partition.

2b (Conditional) If you installed and clustered the DVA along with the POA, make a note of 
that configuration choice.

3 Click Save to save the post office description.
4 Select the Objects tab > Post Office Agents, and click the Post Office Agent object.
5 In the Description field of the POA General tab, record the secondary IP address of the post 

office’s GroupWise partition.
This information appears on the POA server console, no matter which node in the cluster it is 
currently running on.

6 Click Save to save the description.
7 Select the Agents Settings tab of the POA object.
8 In the Host Name field under Network Address, provide the host name address that you 

provided in the GroupWise Installation program.
9 Select Bind exclusively to Host Name.

This records this vital information in eDirectory as well as in the POA startup file.
10 Click Save to save the POA description and secondary IP address.

Knowing What to Expect in MTA, POA, and DVA Failover Situations
In a failover situation, the MTA and the POA might need to perform some database repair as they 
start on the new node. The time required depends on the size of the databases involved.

Typically, the POA returns to full functionality faster than the MTA. This benefits GroupWise client 
users, who can reconnect to their mailboxes very quickly and probably do not notice if messages to 
users in other post offices are not delivered immediately. The only time a user needs to restart the 
GroupWise client is if he or she was actually in the process of sending a message when the POA went 
down. Notify can continue running even if the connection to the POA becomes unavailable because 
it reconnects automatically when the POA is again available.

The MTA typically takes some time reestablishing the links to its post offices, other domains, and 
gateways, but this situation usually resolves itself in a few minutes without administrator 
intervention. If it does not, you can manually restart the MTA to speed up the process.

The DVA must reestablish its HTTP connections with one or more POAs and WebAccess Applications. 
Typically, this occurs quite quickly.

In comparison to failover, migration typically takes longer because the POA and the MTA 
methodically terminate their threads and close their databases as part of their normal shutdown 
procedure. However, as a result, no database repair is required when these agents start up again in 
their new location.

Continue with What’s Next.
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What’s Next
Now that you have at least one GroupWise domain and post office up and running in a clustering 
environment, you are ready to proceed with the rest of your GroupWise system setup by:

 Adding users to post offices.

See “Users” in the GroupWise Administration Guide.
 Setting up the GroupWise Windows client software and helping users to get started using it.

See “Client” in the GroupWise Administration Guide. Also see the GroupWise Client User Guide.
 Connecting your clustered GroupWise system to the Internet.

See Implementing the Internet Agent in a Linux Cluster.

GroupWise System Quick Checklist
Use this checklist when setting up clustering in your GroupWise system.

 Plan your new clustered GroupWise system.

See Planning GroupWise in a Linux Cluster.
 Create the primary domain and initial post office in your new clustered GroupWise system.

See Creating a New GroupWise System to Work with OES Cluster Services.
 Create a new secondary domain in the Linux cluster.

See Creating a New Secondary Domain in a Linux Cluster.
 Test your new clustered GroupWise system.

See Testing Your Clustered GroupWise System on Linux.
 Record cluster-specific information in the properties pages of the GroupWise objects that the 

information pertains to.
See Managing Your Clustered GroupWise System on Linux.

Upgrading a Clustered Linux GroupWise System to 
GroupWise 18

Reference the content in these sections if you already have GroupWise running on a cluster and you 
need to upgrade to a newer version of GroupWise.

 “Installing the GroupWise Software” on page 30
 “Configuring the GroupWise Admin Service to Function in a Cluster” on page 30
 “Upgrading Domains and Post Offices” on page 31
 “Finishing the GroupWise Software Upgrade” on page 32
 “Providing New Load and Unload Scripts” on page 32
 “Testing the Upgraded Cluster” on page 34
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Installing the GroupWise Software
As with any upgrade, you must upgrade the primary domain first.

1 Stop all GroupWise agents that are running on the node that you want to upgrade first.
2 Install the GroupWise Server component on the first node.

Follow the instructions in Step 1 through Step 9 in “Linux: Installing the GroupWise Server 
Software” in the GroupWise Installation Guide.

IMPORTANT: Do not start the GroupWise Admin console after installing the GroupWise 
software.

3 Continue with Configuring the GroupWise Admin Service to Function in a Cluster.

Configuring the GroupWise Admin Service to Function in a 
Cluster
You must configure the GroupWise Admin Service to function in a cluster, so that it keeps track of 
which cluster resources are available to it at each point in time. Configuring the GroupWise Admin 
Service for clustering ensures that files associated with domains and post offices are created on 
cluster volumes, rather than on individual cluster nodes.

1 Run the following command to enable the GroupWise Admin Service to run in a clustering 
environment:

gwadminutil config -cluster enable
You should receive the following response:

Cluster: enabled
Default Port: 9710

2 Use the following command to restart the GroupWise Admin Service.

File Standard Location Clustered location

Domain SSL Certificate, 
MTA SSL Certificate, GWIA 
SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates
(a peer to the domain folder)

Post Office SSL Certificate, 
POA SSL Certificate

/opt/novell/groupwise/certificates /groupwise/certificates
(a peer to the post office folder)

MTA Log Files /var/log/novell/groupwise/
domain.mta

/groupwise/agents/logs
(a peer to the domain folder)

GWIA Log Files /var/log/novell/groupwise/
gwia.domain

/groupwise/agents/logs
(a peer to the domain folder)

POA Log Files /var/log/novell/groupwise/
post_office.poa

/groupwise/agents/logs
(a peer to the post office folder)
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rcgrpwise restart gwadminservice
Your GroupWise system is now ready to function in a cluster.

3 For convenience, configure the GroupWise Installation console to use an authentication mode 
of a user name and password, rather than the default token-based authentication mode:

gwadminutil installcfg -m user -u user_name -p password
4 Continue with Upgrading Domains and Post Offices.

Upgrading Domains and Post Offices
For background information about upgrading your GroupWise system, see “GroupWise System 
Upgrade” in the GroupWise Installation Guide.

1 In a web browser, start the GroupWise Installation console:

https://domain_server_secondary_ip_address:9710/gwadmin-console/
install

2 Provide the user name as password that you established in Step 3 in Configuring the GroupWise 
Admin Service to Function in a Cluster.

3 In the GroupWise Installation console, click Upgrade an Existing Domain or Post Office 
GroupWise 18.
The Installation console provides a list of agents on the current node. The list is built from the 
gwha.conf file.

4 (Conditional) If there are any domains or post offices that are not currently online to this node, 
select them, and then click Remove to remove them from the list.

5 For each domain and post office, verify that the IP address in the list is the secondary IP address 
of the cluster resource.

6 For each domain and post office, verify that there are no port conflicts for the Admin port.
7 (Conditional) If you need to change the IP address or Admin port for a domain or post office, 

click the name of the domain or post office, update the information, and then click OK.
8 Click Next to continue with the upgrade.
9 On the Credentials page:

9a (Conditional) If the primary domain is being upgraded, specify the user name for the 
GroupWise Super Admin, and type the password twice for confirmation.
or
Specify the IP address, Admin port, and Admin credentials of the owning domain.

10 Click Next to display the Summary page.
11 Review the summary, and then click Finish.
12 Continue with Finishing the GroupWise Software Upgrade.
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Finishing the GroupWise Software Upgrade
To finish the GroupWise Software Upgrade, you need to repeat the same tasks above on each cluster 
node:

1 On each cluster node, repeat the steps in the following sections:
 Installing the GroupWise Software
 Configuring the GroupWise Admin Service to Function in a Cluster
 Upgrading Domains and Post Offices

Remember that you cannot upgrade a post office until its owning domain has been 
upgraded.

2 Continue with Providing New Load and Unload Scripts.

Providing New Load and Unload Scripts
After upgrade, you need to replace the existing “load” and “unload” scripts as shown in the example 
steps below:

1 In iManager, replace the existing load script for each cluster resource with a new load script that 
is similar to the following example:

#!/bin/bash
./opt/novell/ncs/lib/ncsfuncs
exit_on_error nss /poolact=DOM
exit_on_error ncpcon mount DOM=254
exit_on_error add_secondary_ipaddress 151.155.136.248
exit_on_error ncpcon bind --ncpservername=DOM --
ipaddress=151.155.136.248
exit_on_error novcifs --add '--
vserver=".cn=DOM.ou=servers.o=novell.t=GW14-TREE."'

--ip-addr=151.155.136.248
# Start gwadmin service
exit_on_error /etc/init.d/grpwise start gwadminservice
#create agent services
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/utah
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 

-i /media/nss/DOM/utah/
wpgate/gwia
exit_on_error /opt/novell/groupwise/admin/gwadminutil services

-i /media/nss/DOM/provo/
#start admin service listeners
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start utah 
cluster
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start provo.utah
cluster
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#start GroupWise agents
exit_on_error /etc/init.d/grpwise start utah
exit_on_error /etc/init.d/grpwise start gwia.utah
exit_on_error /etc/init.d/grpwise start provo.utah
exit 0
This sample cluster load script performs the following actions:
 Establishes what to do for certain error conditions.
 Creates the GroupWise agent services (if they do not already exist).
 Starts the GroupWise Admin Service listeners with clustering enabled for the MTA and 

POA.
 Starts the POA, MTA, and GWIA (in that order if all are present)

2 Replace the existing unload script for each cluster resource with a new unload script that is 
similar to the following example:

#!/bin/bash
. /opt/novell/ncs/lib/ncsfuncs
# Stop admin service listeners
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop utah
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop provo.utah
# Stop GroupWise agents
ignore_error /etc/init.d/grpwise stop utah
ignore_error /etc/init.d/grpwise stop gwia.utah
ignore_error /etc/init.d/grpwise stop provo.utah
ignore_error novcifs 

--remove '--vserver=".cn=DOM.ou=servers.o=novell.t=GW14-
TREE."' 

--ip-addr=151.155.136.248
ignore_error ncpcon unbind --ncpservername=DOM --
ipaddress=151.155.136.248
ignore_error del_secondary_ipaddress 151.155.136.248
ignore_error nss /pooldeact=DOM
exit 0
This sample cluster unload script performs the following actions:
 Stops the GroupWise Admin Service listeners for the MTA and POA
 Stops the MTA, GWIA, and POA (in that order if all are present)
 Lists error conditions that can be ignored

NOTE: The pkill command used in earlier versions of the GroupWise unload script is no 
longer needed. In GroupWise 18, the grpwise script terminates GroupWise agent processes 
according to the wait setting specified in the gwha.conf file. The default is 60 seconds. If that 
amount of time is not sufficient to ensure a clean shutdown of the agents in your GroupWise 
system, increase the wait setting as needed.

3 Continue with Testing the Upgraded Cluster.
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Testing the Upgraded Cluster
Follow the instructions in Testing Your Clustered GroupWise System on Linux to verify that the 
GroupWise Administration Console keeps track of the cluster resources that are currently available 
to it.

Implementing the Document Viewer Agent in a Linux 
Cluster

Clustering is not necessary in order to provide high availability for the DVA, because the DVA does 
not require the database access that is required by the MTA and POA. As an alternative to clustering 
the DVA, you can install the DVA on multiple servers outside the cluster, as described in “Scaling Your 
DVA Installation” in the GroupWise Administration Guide.

However, if you want to include the DVA in the Linux cluster, follow these instructions:

1 Edit the DVA startup file by adding the --ip switch with the secondary IP address.
For information, see “Changing the DVA IP Address or Port Number” in the GroupWise 
Administration Guide.

2 Add the following lines to the load and unload scripts following the procedure in Providing New 
Load and Unload Scripts:
Load script:
 In the # Start gwadmin service section, add:
exit_on_error /opt/novell/groupwise/admin/gwadminutil services -i -
dva /media/nss/cluster/ volume/groupwise/agents/share/dva startup 
file

 In the # Start GroupWise agents section, add:
exit_on_error /etc/init.d/grpwise start gwdva.poname

Unload script: In the # Stop GroupWise agents section, add:
ignore_error /etc/init.d/grpwise stop gwdva.poname

Implementing the Internet Agent in a Linux Cluster
You should already have set up at least a simple GroupWise system, as described in Planning 
GroupWise in a Linux Cluster and Creating a New GroupWise System to Work with OES Cluster 
Services. As part of this process, you filled out the System Clustering Worksheet. If you do not have 
access to the filled-out worksheet, print the worksheet now and fill in the clustering information as it 
currently exists on your system. You need this information as you implement the Internet Agent 
(GWIA) in a cluster.

 “Planning the Internet Agent in a Linux Cluster” on page 35
 “Setting Up the GWIA in a Linux Cluster” on page 38
 “Testing the Internet Agent in a Linux Cluster” on page 43
 “Managing the Internet Agent in a Linux Cluster” on page 44
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 “Internet Agent Clustering Worksheet” on page 45
 “Internet Agent Quick Checklist” on page 45

Planning the Internet Agent in a Linux Cluster
A major system configuration difference between the GWIA in a clustering environment and the 
GWIA in a regular environment is that you need to create a separate domain to house the GWIA in 
the clustering environment.

The Internet Agent Clustering Worksheet lists the information you need as you set up the GWIA in a 
clustering environment. You should print the worksheet and fill it out as you complete the tasks 
listed below:

 “Planning a Domain for the GWIA” on page 35
 “Selecting the GWIA Partition and Secondary IP Address” on page 36
 “Determining an Appropriate Failover List for the Linux GWIA” on page 36
 “Cluster Resource Information for the Linux GWIA” on page 36
 “Preparing DNS for the Clustered Linux GWIA” on page 37
 “Preparing Your Firewall for the Clustered Linux GWIA” on page 37
 “Planning the Linux GWIA Installation” on page 37

Planning a Domain for the GWIA
The considerations involved in planning a domain for the GWIA are much the same as planning any 
other domain. In preparation, review “Planning a Domain”; then, print and fill out the “Primary 
Domain Worksheet”in the GroupWise Installation Guide.

Keep in mind the following cluster-specific details:

 When you specify the location for the domain directory on the Domain Worksheet, remember 
that it is on a GroupWise partition, not on the node where you running the GroupWise 
Installation program. This location is referred to as the GWIA partition because it is where the 
GWIA message queues are located.

 Do not concern yourself with the GroupWise agent information on the Domain Worksheet. You 
can stop at “MTA Settings”. MTA planning will be discussed later.

When you have completed the Domain Worksheet, transfer the key information from the Domain 
Worksheet to the Internet Agent Clustering Worksheet.

IMPORTANT: Do not create the new domain until you are instructed to do so in Creating a Domain 
for the GWIA.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 1: GroupWise Partition for the GWIA, transfer the domain location to the Internet Agent 
Clustering Worksheet.

Under Item 2: GWIA Domain Name, transfer the domain name and database directory to the Internet Agent 
Clustering Worksheet.
OES Cluster Services (NCS) on Linux 35

https://www.novell.com/documentation/groupwise24/pdfdoc/gw_guide_install/gw_guide_install.pdf#instcreateplandomain
https://www.novell.com/documentation/groupwise24/pdfdoc/gw_guide_install/gw_guide_install.pdf#instcreateplanworksheetsprimarydomain
https://www.novell.com/documentation/groupwise24/pdfdoc/gw_guide_install/gw_guide_install.pdf#instcreateplanworksheetsprimarydomain


Selecting the GWIA Partition and Secondary IP Address
As with the MTA, the POA, and the DVA, the GWIA needs a secondary IP address that remains the 
same no matter which node in the cluster it is running on. You can place the GWIA and its domain on 
a GroupWise partition where a domain or post office already reside, which means that the GWIA 
shares the same secondary IP address as that domain or post office and fails over along with that 
domain or post office. Or you can place the GWIA and its domain on its own GroupWise partition, 
which means that it has its own secondary IP address and fails over independently.

IMPORTANT: You must configure the GWIA to bind exclusively to the secondary IP address. OES 
Cluster Services uses Postfix to send cluster email alerts using the primary IP address. Postfix and the 
GWIA both default to port 25. A conflict results unless you configure the GWIA so that it does not 
use the primary IP address. Instructions are provided in Forcing Use of the GWIA Secondary IP 
Address.

Determining an Appropriate Failover List for the Linux GWIA
By default, a GroupWise partition is configured to have all nodes in the cluster in its failover list, 
organized in ascending alphanumeric order. Only one node at a time can have a particular 
GroupWise partition mounted and active. If a GroupWise partition’s preferred node fails, the 
partition fails over to the next node in the failover list. You should customize the failover list for each 
GroupWise partition based on the fan-out-failover principle.

As with the MTA, the POA, and the DVA, you need to decide which nodes in the cluster are 
appropriate locations for the GWIA partition to fail-over to. You must install the GWIA software on 
all of the nodes where you want the GWIA to be able to fail-over. For a review of failover lists, see 
Determining Appropriate Failover Lists for the Linux Agents, which describes the issues in the 
context of planning installations for the other GroupWise agents.

Cluster Resource Information for the Linux GWIA
A cluster resource is a shared partition, secondary IP address, application, service, Web server, and 
so on, that can function successfully anywhere in the cluster. Cluster resources include the 
GroupWise agents and the Messenger agents.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 1: GroupWise Partition for GWIA, specify the secondary IP address for the GWIA partition.

Under Item 5: MTA Network Information, copy the same secondary IP address.

Under Item 6: GWIA Network Information, copy the same secondary IP address.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 3: GWIA Failover List, list the nodes that you want in the GWIA partition failover list.
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Preparing DNS for the Clustered Linux GWIA
In order for the GWIA partition to be recognized on your network, DNS must have an MX record that 
includes the hostname corresponding to the secondary IP address of the GWIA partition. A DNS A 
record associates the secondary IP address with the hostname.

Preparing Your Firewall for the Clustered Linux GWIA
The GWIA receives incoming messages on the secondary IP address of the GWIA partition. Your 
firewall configuration must be modified to allow inbound TCP/IP traffic from the Internet to the 
GWIA secondary IP address on the following standard ports:

By default, the GWIA sends outgoing messages on the primary IP address of the server where it is 
running. If you decide to use this default configuration, your firewall must be configured to allow 
outbound TCP/IP traffic from all nodes in the GWIA partition failover list. However, because Postfix 
uses the primary IP address for sending cluster email alerts, the default GWIA configuration is not 
recommended. To avoid a port conflict, configure the GWIA to bind to the secondary IP address, as 
described in Forcing Use of the GWIA Secondary IP Address.

If the GWIA has a large number of nodes on its failover list, you can configure the GWIA to send 
outgoing messages to a relay host, which then sends them out through the firewall using its own IP 
address rather than the address of the particular node where the GWIA was running. This reduces 
the amount of modification to your firewall required to set up the GWIA. However, if the relay host 
goes down, outgoing messages are delayed.

In preparation for installing the GWIA, configure your firewall as needed to handle the GWIA’s use of 
primary and secondary IP addresses when sending and receiving messages.

Planning the Linux GWIA Installation

IMPORTANT: Do not install the GWIA software until you are instructed to do so in Setting Up the 
GWIA in a Linux Cluster.

INTERNET AGENT CLUSTERING WORKSHEET

Under Item 4: Cluster Resource Mount Point, list the mount point for the GroupWise partition where the 
GWIA domain is located.

Protocol Standard Port

IMAP4 143

LDAP 389

POP3 110

SMTP 25
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Setting Up the GWIA in a Linux Cluster
You should already have reviewed Planning the Internet Agent in a Linux Cluster and filled out the 
Internet Agent Clustering Worksheet. You are now ready to complete the following tasks to set up 
the GWIA in a clustering environment:

 “Creating a Domain for the GWIA” on page 38
 “Configuring the Linux GWIA in a Cluster” on page 38

Creating a Domain for the GWIA
The GWIA domain will be a secondary domain. To create it, follow the instructions in Creating a New 
Secondary Domain in a Linux Cluster, taking your information from the GWIA Clustering Worksheet, 
rather than the System Clustering Worksheet, and then return to this point.

Do not create any post offices in the GWIA domain.

After you have created the domain, continue with Configuring the Linux GWIA in a Cluster.

Configuring the Linux GWIA in a Cluster
After you have created a domain for the GWIA , you are ready to  configure the GWIA.

 “Configuring the Clustered Linux GWIA for SSL” on page 38
 “Configuring the Linux GWIA Cluster Resource to Load and Unload the GWIA and Its MTA” on 

page 39
 “Enabling Internet Addressing for Your Clustered GroupWise System” on page 42
 “Forcing Use of the GWIA Secondary IP Address” on page 42
 “Verifying GWIA Object Settings” on page 42

Configuring the Clustered Linux GWIA for SSL
If you plan to enable SSL, as described in “Securing Internet Access with TLS Connections to the 
GWIA” in the GroupWise Administration Guide, you must make the SSL certificate file and key file 
available to the GWIA in the cluster. The default locations for the SSL certificate file and key file are 
on the cluster nodes along with the GroupWise software, rather than being located with the domain 
and post office on one or more GroupWise partitions. To avoid having multiple copies of these files 
in multiple locations, you should set the locations in the Administration Console.

1 On the GWIA partition, create the directory where you want to store the certificate and key file 
required for SSL.

2 Copy the certificate file and key file into the new directory.
If you need assistance obtaining these files, see “Encryption and Certificates” in the GroupWise 
Administration Guide.

3 Continue by following the instructions in “Securing Internet Access with TLS Connections to the 
GWIA” in the GroupWise Administration Guide.

4 Continue with Configuring the Linux GWIA Cluster Resource to Load and Unload the GWIA and 
Its MTA.
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Configuring the Linux GWIA Cluster Resource to Load and Unload the GWIA and Its 
MTA
The properties of the Cluster Resource object define how the GWIA partition functions within the 
cluster, how the GWIA is loaded and unloaded, and how failover and failback situations are handled. 
Complete the following tasks for the GWIA cluster resource:

 “Modifying the Cluster Resource Load Script for the Linux GWIA and Its MTA” on page 39
 “Modifying the Cluster Resource Unload Script for the Linux GWIA and Its MTA” on page 40
 “Setting the Failover List and Policies for the Linux GWIA and Its MTA” on page 41

Modifying the Cluster Resource Load Script for the Linux GWIA and Its MTA

The cluster resource load script executes whenever the GWIA cluster resource comes online.

To set up the load script in iManager:

1 Expand Clusters, and then click Cluster Options.
2 In the Cluster field, browse to the Cluster object where the GWIA cluster resource is located.
3 Click the Cluster object to display the cluster resources that belong to the cluster.
4 Select the GWIA cluster resource that you created when you set up the GWIA partition, and 

then click Details.
5 Click Scripts > Load Script.
6 (Conditional) If this is a traditional Linux volume, use a load script similar to the following 

example, depending on the configuration of your cluster and nodes. This sample cluster load 
script performs the following actions:
 Establishes what to do for certain error conditions
 Creates the GroupWise agent services (if they do not already exist)
 Starts the GroupWise Admin Service listeners with clustering enabled for the MTA
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 Starts the MTA and GWIA (in that order)

#!/bin/bash
./opt/novell/ncs/lib/ncsfuncs
exit_on_error nss /poolact=DOM
exit_on_error ncpcon mount DOM=254
exit_on_error add_secondary_ipaddress 151.155.136.248
exit_on_error ncpcon bind --ncpservername=DOM --
ipaddress=151.155.136.248
exit_on_error novcifs --add '--
vserver=".cn=DOM.ou=servers.o=novell.t=GW14-TREE."'
                      --ip-addr=151.155.136.248
# Start gwadmin service
exit_on_error /etc/init.d/grpwise start gwadminservice
#create agent services
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 
                                                -i /media/nss/DOM/utah
exit_on_error /opt/novell/groupwise/admin/gwadminutil services 
                                               -i /media/nss/DOM/
utah/wpgate/gwia
#start admin service listeners
exit_on_error /opt/novell/groupwise/admin/gwadmin-ipc start utah 
cluster
#start GroupWise agents
exit_on_error /etc/init.d/grpwise start utah
exit_on_error /etc/init.d/grpwise start gwia.utah
exit 0

6a In the define IP address section, specify the secondary IP address of the GWIA 
partition (Internet Agent Clustering Worksheet item 1).

6b In the define filesystem type section, specify the filesystem type that is in use in use 
on the nodes in the cluster (System Clustering Worksheet item 5).

6c In the define mount point section, specify the mount point directory in use for the 
nodes in the cluster (System Clustering Worksheet item 5).

6d In the start service section, provide the commands to start the MTA first, following by 
the GWIA.

7 Click OK to save the load script.

Modifying the Cluster Resource Unload Script for the Linux GWIA and Its MTA

The cluster resource unload script executes whenever the GWIA cluster resource goes offline. 
Programs should be unloaded in the reverse order of how they were loaded. This ensures that 
supporting programs are not unloaded before programs that rely on them in order to function 
properly.

1 On the iManager Cluster Resource Properties page of the GWIA cluster resource, click Scripts > 
Unload Script.

2 (Conditional) If this is a traditional Linux volume, use an unload script similar to the following 
example, depending on the configuration of your cluster and nodes. This sample cluster unload 
script performs the following actions:
 Stops the GroupWise Admin Service listeners for the MTA
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 Stops the MTA and GWIA (in that order)
 Lists error conditions that can be ignored

#!/bin/bash
. /opt/novell/ncs/lib/ncsfuncs
# Stop admin service listeners
ignore_error /opt/novell/groupwise/admin/gwadmin-ipc stop utah
# Stop GroupWise agents
ignore_error /etc/init.d/grpwise stop utah
ignore_error /etc/init.d/grpwise stop gwia.utah
ignore_error novcifs 
             --remove '--vserver=".cn=DOM.ou=servers.o=novell.t=GW14-
TREE."' 
             --ip-addr=151.155.136.248
ignore_error ncpcon unbind --ncpservername=DOM --
ipaddress=151.155.136.248
ignore_error del_secondary_ipaddress 151.155.136.248
ignore_error nss /pooldeact=DOM
exit 0
2a In the request service stop section, provide the commands to stop the GWIA first, 

followed by the MTA.
2b In the stop service otherwise section, adjust the sleep command as needed so that 

the agents can shut down normally on your system without being inadvertently killed by 
the pkill command the follows.

2c In the define IP address section, specify the secondary IP address of the GWIA 
partition.

2d In the define mount point section, specify the mount point directory in use for the 
nodes in the cluster.

2e (Conditional) If you are running the GroupWise High Availability (gwha) service, stop it 
before the script stops the agents, and then start it again at the end of the unload script.
This prevents the GroupWise High Availability service from trying to restart the agents 
while the script is trying to stop them.
Add the following section before the request service stop section:

# Temporarily disable the gwha service under xinetd
ignore_error /sbin/chkconfig -s gwha off
ignore_error kill -HUP `pidof xinetd`
Add the following section before the return status section:

# Restart the gwha service under xinetd
ignore_error /sbin/chkconfig -s gwha on
ignore_error kill -HUP `pidof xinetd`

3 Click OK to save the unload script.

Setting the Failover List and Policies for the Linux GWIA and Its MTA

1 On the iManager Cluster Resource Properties page of the GWIA cluster resource, click General.
The default policy settings are often appropriate. By default, a cluster resource:
 Fails over automatically if the node it is running on fails
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 Starts automatically on the next node in its failover list
 Continues running at its failover location, even after its most preferred node is again 

available
If you are considering changing these defaults, see the OES Cluster Services for Linux 
Administration Guide for your version of OES Linux.

2 Under Preferred Nodes, arrange the nodes in the cluster into the desired failover list for the 
GWIA (Internet Agent Clustering Worksheet item 3).

3 Click OK.

Enabling Internet Addressing for Your Clustered GroupWise System
Setting up Internet addressing for a clustered GWIA is no different from setting it up for an GWIA in 
any other environment. Follow the instructions in “Configuring Internet Addressing” in the 
GroupWise Administration Guide, and then return to this point.

Forcing Use of the GWIA Secondary IP Address
OES Cluster Services uses Postfix to send cluster email alerts using the primary IP address. Postfix 
and the GWIA both default to using port 25. You must configure the GWIA to bind exclusively to the 
secondary IP address in order to avoid a port conflict between Postfix and the GWIA.

1 Click the GWIA object in the GroupWise Administration Console.
2 Navigate to GroupWise tab > Agent Settings.
3 In the Host Name field under Network Address, provide the secondary IP address (Internet 

Agent Clustering Worksheet item 1) for the GWIA to use for sending outgoing messages.
4 Select Bind Exclusively to Host Name.
5 Click OK.
6 Continue with Verifying GWIA Object Settings.

Verifying GWIA Object Settings
During installation of the GWIA, the GWIA object should have been configured correctly. However, it 
can be helpful to verify certain cluster-specific information in order to familiarize yourself with the 
configuration of a clustered GWIA.

 “Accessing GWIA Object Settings” on page 42
 “Verifying the Reference to the GWIA Cluster Resource” on page 43
 “Verifying the Reference to the Mount Point Directory” on page 43

Accessing GWIA Object Settings

To access GWIA object settings:

1 Browse to and select the GWIA object in the Administration Console in order to display its 
contents.

2 Continue with Verifying the Reference to the GWIA Cluster Resource.
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Verifying the Reference to the GWIA Cluster Resource

In the GWIA object settings:

1 Click SMTP/MIME > Settings.
2 Verify the contents of the Hostname/DNS “A Record” Name field.

This field displays the hostname as currently configured in DNS. It should display the hostname 
that corresponds to the secondary IP address of the GWIA cluster resource. For more 
information, see Preparing DNS for the Clustered Linux GWIA.

3 Make changes if necessary.
4 Continue with Verifying the Reference to the Mount Point Directory.

Verifying the Reference to the Mount Point Directory

In the GWIA object settings:

1 Select the Server Directories tab.
2 Verify that the displayed directories match the mount point directory and the domain directory.
3 Make changes if necessary.

Testing the Internet Agent in a Linux Cluster
After you have configured the GWIA cluster resource, you can test the load and unload scripts by 
bringing the cluster resource online and taking it offline again.

1 In iManager, expand Clusters, and then click Cluster Manager.
2 Browse to the Cluster object to display the current cluster state.
3 (Conditional) If the new GWIA cluster resource shows Offline in the State column, click the new 

GWIA cluster resource, and then click Online.
After a moment, the GWIA cluster resource displays Running in the State column.

4 At the server where the GWIA is starting, use the following command to see that the GWIA has 
started:

/etc/init.d/grpwise status domain.gwia
5 Select the new GWIA cluster resource, and then click Offline.

The State column for the GWIA cluster resource returns to Offline.
6 Use the same command that you used in Step 4 to verify that the GWIA has stopped.
7 Repeat Step 3 whenever you are ready to bring the new GWIA cluster resource online 

permanently.
8 Continue with Managing Your Clustered GroupWise System on Linux.
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Managing the Internet Agent in a Linux Cluster
After you have installed the GWIA in a cluster, you should consider some long-term management 
issues.

 “Updating GroupWise Objects with Cluster-Specific Descriptions” on page 44
 “Knowing What to Expect in an GWIA Failover Situation” on page 44

Updating GroupWise Objects with Cluster-Specific Descriptions
After installing the GWIA in your clustered GroupWise system, while the cluster-specific information 
is fresh in your mind, you should record the cluster-specific information as part of the GroupWise 
objects in the GroupWise Administration Console so that you can easily refer to it later. Be sure to 
update the information in the GroupWise objects if the configuration of your system changes.

Recording Cluster-Specific Information about the GWIA Domain and Its MTA
To permanently record important cluster-specific information for the GWIA domain:

1 Browse to and click the Domain object in the Administration Console.
2 Navigate to Objects tab > Internet Agents, and click the GWIA object.
3 In the Description field of the GWIA General tab, provide a cluster-specific description of the 

GWIA domain, including the secondary IP address of its GroupWise partition.
4 Click Save to save the GWIA domain description.
5 Browse to and click the MTA object.
6 In the Description field of the MTA General tab, record the secondary IP address of the 

GroupWise partition.
This information appears on the MTA console, no matter which node in the cluster it is currently 
running on.

7 Click Save to save the MTA description.

Knowing What to Expect in an GWIA Failover Situation
The failover behavior of the MTA for the GWIA domain is the same as for an MTA in a regular 
domain. See Knowing What to Expect in MTA, POA, and DVA Failover Situations.

Failover of the GWIA itself is more complex. The various clients (POP3, IMAP4, and LDAP) receive an 
error message that the node is not available. Most of the clients do not attempt to reconnect 
automatically, so the user must exit the client and restart it to reestablish the connection after the 
failover process is complete. Fortunately, the GWIA restarts quickly in its failover location so users 
can reconnect quickly.

As with the MTA, the POA, and the DVA, migration of the GWIA takes longer than failover. In fact, the 
GWIA can seem especially slow to shut down properly as it finishes its normal processing and stops 
its threads. For a busy GWIA, you might need to wait several minutes for it to shut down properly.
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Internet Agent Clustering Worksheet

Internet Agent Quick Checklist
 Plan the new clustered GWIA, including the new domain required to house the GWIA in a 

clustering environment.

See Planning the Internet Agent in a Linux Cluster.
 Make sure DNS includes the secondary IP address of the GWIA partition

See Preparing DNS for the Clustered Linux GWIA
 Make sure your firewall is configured to accommodate the GWIA.

See Preparing Your Firewall for the Clustered Linux GWIA.
 Create the new GWIA domain.

See Creating a Domain for the GWIA.
 Modify the GWIA cluster resource load script.

See Modifying the Cluster Resource Load Script for the Linux GWIA and Its MTA.
 Modify the GWIA cluster resource unload script.

See Modifying the Cluster Resource Unload Script for the Linux GWIA and Its MTA.
 Set up the GWIA failover list and policies.

See Setting the Failover List and Policies for the Linux GWIA and Its MTA.
 Enable Internet Addressing for the clustered GWIA.

Item Explanation

1) GroupWise Partition for 
the GWIA:

Secondary IP Address:

Specify the GroupWise partition where the GWIA domain 
will be created, along with its secondary IP address.

For more information, see Selecting the GWIA Partition 
and Secondary IP Address.

2) GWIA Domain Name:

Domain Database Location:

Specify a unique name for the GWIA domain. Specify the 
directory on the GroupWise partition where you want to 
create the new domain.

For more information, see Planning a Domain for the 
GWIA.

3) GWIA Failover List: List other nodes in the cluster where the GWIA and its 
MTA can fail-over.

For more information, see Determining an Appropriate 
Failover List for the Linux GWIA.

4) Cluster Resource Mount 
Point:

Specify the mount point directory where the GWIA 
domain will be mounted.

For more information, see Cluster Resource Information 
for the Linux GWIA.
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See Enabling Internet Addressing for Your Clustered GroupWise System.
 Double-check the cluster-specific GWIA object properties.

See Verifying GWIA Object Settings.
 Test the clustered GWIA.

See Testing the Internet Agent in a Linux Cluster.
 Record cluster-specific information in the properties pages of the GroupWise objects associated 

with the GWIA.
See Updating GroupWise Objects with Cluster-Specific Descriptions.

Implementing the GroupWise Web Applications in a 
Cluster

Clustering the GroupWise Web applications (WebAccess, Calendar Publishing Host, and Monitor) is 
not currently supported.

Because the GroupWise Web applications are installed into your Web server, clustering the 
GroupWise Web applications would entail clustering your entire Web server. If you are already 
successfully clustering your Web server, you should be able to install the GroupWise Web 
applications into that clustered Web server in the same way that you have installed other Web 
applications into your clustered Web server. However, you cannot receive support to set up this 
configuration of the GroupWise Web applications. For guidance, refer to the GroupWise 
Knowledgebase article, Installing GW Web on an OES cluster in the Support Portal.

Upgrading a GroupWise System in a Linux Cluster
In a Linux cluster, you must install the GroupWise software on each node in the cluster. Before you 
run the GroupWise Installation program to install updated software, make sure you know all the 
cluster nodes where the GroupWise software is already installed.

It is very important to update all nodes on the failover list of each domain and post office at the 
same time because each domain and post office should be serviced by only one version of the agent 
software. If you do not update all nodes on the failover list at once, there is the potential for a 
domain or post office to be serviced by a different version of the agent software during a failover 
situation. This can cause database problems.

Keep in mind these cluster-specific details as you follow the instructions in “GroupWise System 
Upgrade” in the GroupWise Installation Guide to upgrade your GroupWise system in a Linux cluster.
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Moving an Existing Linux GroupWise System into a Linux 
Cluster

If you are adding the high availability benefits of OES Cluster Services to a GroupWise system that is 
already up and running, the first step is to install OES Cluster Services, following the instructions in 
OES Cluster Services for Linux Administration Guide for your version of OES Linux. You should also 
review Introduction to GroupWise and OES Cluster Services on Linux to help you apply clustering 
principles and practices to your GroupWise system.

You do not need to transfer your entire GroupWise system into the cluster all at once. You can 
transfer individual post offices where the needs for high availability are greatest. You can transfer a 
domain and all of its post offices at the same time. You might decide that you don’t need to have all 
of your GroupWise system running in the cluster.

This section provides a checklist to help you get started with moving your GroupWise system into a 
clustering environment:

 Decide which shared partitions in your cluster you want to use for GroupWise domains and post 
offices.

 Decide which nodes in your storage area network you want have on failover lists for the 
GroupWise agents.

 Review Planning GroupWise in a Linux Cluster. Fill out the System Clustering Worksheet to help 
you decide which domains and post offices you want move to which shared partitions.

 Move a domain and/or post office onto the GroupWise partition, following the instructions in 
“Moving Your Primary Domain to Another Server” in the GroupWise Administration Guide.

 Review Configuring the Linux Agents in a Cluster, fill out the Agent Clustering Worksheet, and 
install the agents as needed for the first clustered domain and/or post office, following the 
instructions in Creating a New GroupWise System to Work with OES Cluster Services. This 
includes setting up the load and unload scripts for the GroupWise partition.

 Test the first component of your clustered GroupWise system, following the instructions in 
Introduction to GroupWise and OES Cluster Services on Linux.

 Take care of the cluster management details described in Managing Your Clustered GroupWise 
System on Linux.

 Move more domains and post offices into the cluster as needed. If you have GroupWise 
libraries, see Planning a New Library for a Clustered Post Office.

 Add other components to your clustered GroupWise system as needed, following the 
instructions in: Implementing the Internet Agent in a Linux Cluster.
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2 2Using Windows Server Failover Clustering 
with GroupWise

For Windows Server Failover Clustering, GroupWise uses the term “Cluster Role” to define the setup 
that you will go through to create a failover cluster.

 “Creating a New GroupWise System in a Windows Failover Cluster” on page 49
 “Upgrading a Clustered Windows GroupWise System to GroupWise 18” on page 57

Creating a New GroupWise System in a Windows Failover 
Cluster

The following sections assume a working knowledge of Windows Server Failover Clustering.

 “Preparing to Install GroupWise in the Cluster” on page 49
 “Installing the GroupWise Software” on page 50
 “Configuring the GroupWise Admin Service for Clustering” on page 51
 “Creating the Primary Domain” on page 51
 “Creating a Post Office” on page 52
 “Creating a Script to Start and Stop the GroupWise Agents” on page 54
 “Adding the Script to the Cluster Role” on page 55
 “Testing the Cluster Role” on page 56
 “Clustering the DVA” on page 57

Preparing to Install GroupWise in the Cluster
This section includes instructions for creating a cluster role using the role type of “File Server”. For 
each server that you configure with this role, you must have already installed File Server through 
Server Manager in order to configure it as described below.

1 Define at least one Cluster Role.
For a very simple GroupWise system with a primary domain and one post office, you could 
handle the domain and the post office as a single Cluster Role. For a typical GroupWise system 
with multiple domains and post offices, you might to have a Cluster Role for each domain and 
post office.

2 Configure each Cluster Role with the type of File Server.
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3 Configure each File Server Cluster Role with a shared cluster disk and an IP address.
The following example shows two Cluster Roles, ProvoServer and UtahServer.

4 Continue with Installing the GroupWise Software.

Installing the GroupWise Software
To install the GroupWise software:

1 Install the GroupWise Server component on each cluster node where a GroupWise agent will 
run for a domain or a post office.
Follow the instructions in Step 1 through Step 11 in “Windows: Installing the GroupWise Server 
Software” in the GroupWise Installation Guide.

IMPORTANT: Install the GroupWise Server component on all cluster nodes before setting up 
any domains or post offices.

2 Continue with Configuring the GroupWise Admin Service for Clustering.
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Configuring the GroupWise Admin Service for Clustering
Configuring the GroupWise Admin Service for clustering ensures that files associated with domains 
and post offices are created on cluster volumes, rather than on individual cluster nodes.

1 Run the following command to enable the GroupWise Admin Service to run in a clustering 
environment:

gwadminutil config -cluster enable
You should receive the following response:

Cluster: enabled
Default Port: 9710

2 Restart the GroupWise Admin Service.
Use the Windows Services administrative tool.
or
Use the following commands at the Windows command prompt:

sc stop gwadmin
sc start gwadmin

3 Continue with Creating the Primary Domain.

Creating the Primary Domain
To create a primary domain:

1 Ensure that the primary domain Cluster Role is online on the cluster node where you want to 
create the primary domain.

2 Use the GroupWise Install icon on the Windows desktop to access the GroupWise Installation 
console.

File Standard Location Clustered location

Domain SSL Certificate, 
MTA SSL Certificate, GWIA 
SSL Certificate

C:\Program Files\Novell\
GroupWise Server\
certificates

\groupwise\certificates
(a peer to the domain folder)

Post Office SSL Certificate, 
POA SSL Certificate

C:\Program Files\Novell\
GroupWise Server\
certificates

\groupwise\certificates
(a peer to the post office folder)

MTA Log Files \domain_folder\mslocal \groupwise\agents\logs
(a peer to the domain folder)

GWIA Log Files \domain_folder\wpgate\000.prc \groupwise\agents\logs
(a peer to the domain folder)

POA Log Files \post_office_folder\wpcsout\ofs \groupwise\agents\logs
(a peer to the post office folder)
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3 (Conditional) If you receive a certificate error, continue past it.
4 Follow the instructions in “Creating the Primary Domain” in the GroupWise Installation Guide.

Pay special attention to the Host and Domain Folder fields on the System Settings page.

 In the Host field, specify the IP address of the domain Cluster Role.
 In the Domain Folder field, specify a folder on the domain Cluster Role volume.

The clustering example used in this section sets up a GWIA in the primary domain but does 
not create any post offices on the primary domain server. The post office will be created 
later on a different Cluster Role.

5 Continue following the standard instructions to finish creating the primary domain.

NOTE: After you create the primary domain on its Cluster Role, the GroupWise Install and 
GroupWise Administration desktop icons no longer work. The Admin Service is now listening on 
the IP address of the primary domain Cluster Role, not the IP address of the physical node.

6 (Optional) Create new desktop shortcuts for the Installation console and the Administration 
console that use the proper IP address.

7 Continue with Creating a Post Office.

Creating a Post Office
Although you can create a post office on the same Cluster Role with a domain, it is not typical to do 
so. In this example, the post office is created on a separate Cluster Role.

1 Online the post office Cluster Role to a cluster node.
2 Use the GroupWise Install icon on the Windows desktop to access the GroupWise Installation 

console.
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3 Follow the instructions in Step 2 through Step 8 in “Adding a Post Office” in the GroupWise 
Installation Guide.
As with the domain creation process, pay special attention to specific fields.
3a On the System Settings page:

 In the Owning Domain Host field, specify the IP address of the primary domain Cluster 
Role that you set up in “Creating the Primary Domain” on page 51.

 In the Owning Domain Admin Port field, specify port on the primary domain Cluster 
Role.

3b On the Post Office Settings page:

 In the Host field, specify the IP address of the post office Cluster Role.
 In the Post Office Folder field, specify a folder on the post office Cluster Role volume.

The clustering example used in this section does not set up a DVA with the post office. 
For DVA clustering recommendations, see Clustering the DVA.

4 Continue following the standard instructions to finish creating the post office.

NOTE: As an alternative to creating the post office in the GroupWise Installation console, you 
can create the post office in the GroupWise Admin console. Online the post office Cluster Role 
to the same node where the owning domain Cluster Role is running. Then follow the 
instructions in “Creating a New Post Office on an Existing Domain or Post Office Server” in the 
GroupWise Installation Guide.
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Creating a Script to Start and Stop the GroupWise Agents
When a domain or post office Cluster Role is started, stopped, or moved to a new cluster node, the 
accompanying GroupWise agents must also be started and stopped. The GroupWise Admin Service 
also needs to keep track of when domains and post office are added or removed from its cluster 
node. This is accomplished by adding a Windows cluster Generic Script resource to the domain or 
post office Cluster Role.

The Generic Script performs the following actions:

 Creates a Windows service for each GroupWise agent if the service does not already exist.
 Starts the GroupWise Admin Service for the domain or post office Cluster Role.
 Starts the MTA, and optionally the GWIA, for a domain Cluster Role.
 Starts the POA for a post office Cluster Role.

The Generic Script must be a Visual Basic script. A template is provided in the following location:

C:\Program Files\Novell\GroupWise Server\
agents\data\cluster\groupwise_cluster_template.vbs

The script file provides background information about how to edit the script.

1 Create a folder for the script on each cluster node, such as c:\gwcluster.
2 Copy the template script into the gwcluster folder on each cluster node.
3 Edit the template file for a specific Cluster Role.

For a domain Cluster Role, the script would look similar to the following example, which enables 
the MTA and the GWIA for the Utah domain:

gwAgents.Add "Utah MTA", "M:\Utah"
gwAgents.Add "Utah GWIA", "M:\Utah\wpgate\gwia"
For a post office Cluster Role, the script would look similar to the following example, which 
enables the POA for the Provo post office:

gwAgents.Add "Provo POA", "M:\Provo"
4 Save the edited template file with a descriptive name that associates it with its Cluster Role.
5 Copy the customized script to each cluster node, ensuring that it is in the same location on all 

cluster nodes.
6 Continue with Adding the Script to the Cluster Role.
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Adding the Script to the Cluster Role
To add a script to the cluster role:

1 In the Failover Cluster Manager, stop or offline the Cluster Role.
2 Highlight the Cluster Role.

3 On the Actions menu in the right column, click Add Resource > Generic Script.
4 Select Generic Script as the resource type.

5 Specify the full path to the script.
6 Click Next, and then click Finish.

IMPORTANT: If there are any errors in the script, or if the script is not available on all of the 
cluster nodes, the addition of the Generic Script resource fails.
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7 Edit the properties of the script to add dependencies, so that the file system and IP address are 
enabled on the Cluster Role before the script is run.

7a Highlight the Generic Script resource, and then click Properties on the Script menu on the 
right.

7b Click the Dependencies tab.
7c Click Click here to add a dependency, and then select the Cluster Disk as the first 

dependency.
7d Click Click here to add a dependency again, and then add the IP address.
7e Click OK to save your changes.

8 Continue with Testing the Cluster Role.

Testing the Cluster Role
To test the cluster role:

1 Bring the Cluster Role online.
2 Move the Cluster Role to a different node.
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Clustering the DVA
Complete instructions for clustering the DVA are beyond the scope of this example. The following 
suggestions should help you cluster the DVA:

 Do not install the DVA as part of installing a post office. Instead, install it independently. Use the 
following command on the cluster disk where you want the DVA to run:

gwadminutil services -i -dva 
For more instructions, see the following sections in the GroupWise Installation Guide:
 “Windows: Installing and Starting a New DVA”
 “Setting Up the DVA”

 Create a script and a Generic Script resource to control the DVA. The line for the DVA would look 
similar to the following example:

gwAgents.Add "GWDVA", "M:\Provo"
For instruction, see:
 Creating a Script to Start and Stop the GroupWise Agents
 Adding the Script to the Cluster Role

 Configure the DVA to function in the cluster.
This requires editing the DVA startup file. For instructions, see “Configuring DVA Log Settings” in 
the GroupWise Administration Guide.
Two aspects of the DVA must to customized:
 Configure the DVA with the IP address of the Cluster Role.
 Configure the DVA to create its log files in the following folder:

\groupwise\agents\logs
If you are setting up the DVA as part a post office Cluster Role, this folder has already been 
created when you configured the GroupWise Admin Service to run for the clustered post 
office. If not, you must manually create this folder. In either case, you must configure the 
DVA to have its log files created in this location.

Upgrading a Clustered Windows GroupWise System to 
GroupWise 18

If your existing GroupWise system is in a cluster, you must change the way it is configured in the 
cluster to enable the GroupWise 18 domains, post offices, and agents to function in the cluster.

1 Stop the GroupWise agents for the domain or post office.
2 Remove the cluster Resource Group for the domain or post office.
3 Upgrade each domain or post office.

For instructions, see“GroupWise System Upgrade” in the GroupWise Installation Guide
4 Create a Cluster Role for each domain or post office.

or
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Create a Cluster Role for a domain and one or more post offices, as required by the existing 
architecture of your Windows Failover cluster.
For instructions, see Preparing to Install GroupWise in the Cluster.

5 Create a script to control the agents in the Cluster Role.
For instructions, see:
 Creating a Script to Start and Stop the GroupWise Agents
 Adding the Script to the Cluster Role

6 Test the new Cluster Role.
For instructions, see Testing the Cluster Role.

7 (Optional) Cluster the DVAs in your GroupWise system.
For instructions, see Clustering the DVA.
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II IIMessenger

Reference the content in the sections below to set up and manage Messenger in a Linux cluster.

 Chapter 3, “Implementing Messenger in a Linux Cluster,” on page 61
 Chapter 4, “Checking GroupWise and Messenger Interoperability,” on page 75
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3 3Implementing Messenger in a Linux Cluster

GroupWise Messenger does not require the existence of a GroupWise system in the cluster, but 
presumably one has already been set up as described in Planning GroupWise in a Linux Cluster and 
Creating a New GroupWise System to Work with OES Cluster Services. As part of the process of 
setting up GroupWise in the cluster, you filled out the System Clustering Worksheet. Some of the 
information from that worksheet is helpful as you implement Messenger in your cluster.

 “Planning Your Messenger System in a Linux Cluster” on page 61
 “Setting Up Your Messenger System in a Linux Cluster” on page 63
 “Testing Your Messenger System in a Linux Cluster” on page 71
 “Managing Your Messenger System in a Linux Cluster” on page 72
 “Messenger Clustering Worksheet” on page 72
 “Messenger Clustering Quick Checklist” on page 74

Planning Your Messenger System in a Linux Cluster
Because the Messenger agents are not associated with GroupWise domains or post offices, the 
Messenger agents are easier to implement in a cluster than are the GroupWise agents. The 
Messenger Clustering Worksheet lists the information you need as you set up the Messenger agents 
in a clustering environment. You should print the worksheet and fill it out as you complete the tasks 
listed below:

 “Understanding Your Cluster” on page 61
 “Selecting the Messenger Partition and Secondary IP Address” on page 62
 “Determining an Appropriate Failover List for the Linux Messenger Agents” on page 62
 “Determining Cluster Resource Information for the Linux Messenger Agents” on page 62
 “Planning the Linux Messenger Agent Installation” on page 63

Understanding Your Cluster
As described in Installing OES Cluster Services (NCS) on Linux, you set up your cluster with a certain 
number of shared partitions and cluster resources.

MESSENGER CLUSTERING WORKSHEET

Under Items 1-5, record information about your cluster. This information corresponds to items 1-5 on the 
System Clustering Worksheet.
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Selecting the Messenger Partition and Secondary IP Address
If you are not planning to enable archiving, or if you are not anticipating a large Messenger archive, 
you can use one Messenger partition for both the Messaging Agent and the Archive Agent. If you 
anticipate archiving a large number of messages so that the Messenger archive grows very large, you 
might want to have a separate Messenger partition for the Archive Agent and its archive database. 
The steps in this section focus on setting up the Messenger agents on a single Messenger partition.

Determining an Appropriate Failover List for the Linux 
Messenger Agents
By default, a Messenger partition is configured to have all nodes in the cluster in its failover list, 
organized in ascending alphanumeric order. Only one node at a time can have the Messenger 
partition mounted and active and the Messenger agents running. If a Messenger partition’s 
preferred node fails, the partition fails over to the next node in the failover list. The Messenger 
agents might need to run on any node that the Messenger partition fails over to.

Determining Cluster Resource Information for the Linux 
Messenger Agents
A cluster resource is a shared partition, secondary IP address, application, service, Web server, and 
so on, that can function successfully anywhere in the cluster. Cluster resources include the 
GroupWise agents and the Messenger agents. When you are installing the Messenger agents in a 
cluster, the Messenger Installation program needs to know the mount point for the Messenger 
partition where it can store agent startup files, log files, SSL certificate files, and the uid.conf file 
that enables the Messenger agents to run as a non-root user. By storing these files on a shared 
partition, the Messenger agents can access the files regardless of which node in the cluster the 
agents are currently running on.

MESSENGER CLUSTERING WORKSHEET

Under Item 6: Shared Partition for Messenger, record the name and secondary IP address of the Messenger 
partition in your cluster.

If you want a separate Messenger partition for archiving, under Item 7: Shared Partition for Archiving, record 
the name and secondary IP address of the archiving partition in your cluster.

MESSENGER CLUSTERING WORKSHEET

Under Item 8: Failover List for Messenger Agents, list the nodes that you want to have in the Messenger 
agents’ failover list.

MESSENGER AGENT CLUSTERING WORKSHEET

Under Item 9: Mount Point for Shared Storage, list the mount point directory for the Messenger partition 
where the Messenger startup and other files will be located.
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Planning the Linux Messenger Agent Installation
Aside from the cluster-specific issues discussed in the preceding sections, the considerations 
involved in planning to install the Messenger agents are the same in a clustering environment as for 
any other environment. Review “Planning Your GroupWise Messenger System”; then, print and fill 
out the “GroupWise Messenger Worksheet” in the GroupWise Messenger Installation Guide. 
Messenger must be installed on each node in the failover list (Messenger Clustering Worksheet item 
8)

Continue with Setting Up Your Messenger System in a Linux Cluster.

Setting Up Your Messenger System in a Linux Cluster
You should have already reviewed Planning Your Messenger System in a Linux Cluster and filled out 
the Messenger Clustering Worksheet and the “GroupWise Messenger Worksheet” in the GroupWise 
Messenger Installation Guide.

 “Creating Your Messenger System and Installing the Linux Messenger Agents” on page 63
 “Changing Messenger Paths to Locations on the Messenger Partition” on page 64
 “Configuring the Messenger Cluster Resource to Load and Unload the Linux Messenger Agents” 

on page 67

Creating Your Messenger System and Installing the Linux 
Messenger Agents
The Messenger Installation program walks you through setting up your Messenger system and 
installing the Messenger agents. The first time you run the Messenger Installation program, you 
create your Messenger system, which includes creating various Messenger objects in eDirectory and 
installing the Messenger software on the node where you run the Messenger Installation program. 
After that, you run the Messenger Installation program on each node in the Messenger failover list 
to install the Messenger software on each node, but you do not create any more objects in 
eDirectory.

 “Running the Linux Messenger Installation Program on the Preferred Node” on page 63
 “Running the Linux Messenger Installation Program on Subsequent Nodes” on page 64
 “Testing Your Linux Messenger Agent Installation on Each Node” on page 64

Running the Linux Messenger Installation Program on the Preferred Node
To run the Linux Messenger installation program on the preferred node:

1 Mount the Messenger partition (Messenger Clustering Worksheet item 6) on the mount point 
for shared storage (Messenger Clustering Worksheet item 9).

2 Run the Messenger Installation program, following the steps provided in “Starting the 
Messenger Installation Program” in the GroupWise Messenger Installation Guide.

3 When asked if you are installing to a cluster, enter y for Yes.
4 From the options list, enter 1 for Create a new system.
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5 Specify the mount point for the shared storage.
6 Set up your Messenger system, following the steps provided in “Configuring Your Messenger 

System” in the GroupWise Messenger Installation Guide.
7 Continue with Running the Linux Messenger Installation Program on Subsequent Nodes.

Running the Linux Messenger Installation Program on Subsequent Nodes
1 On the next node in the Messenger failover list (Messenger Cluster Worksheet item 8), mount 

the Messenger partition on the mount point for shared storage.
2 Run the Messenger Installation program.
3 When asked if you are installing to a cluster, enter y for Yes.
4 From the options list, enter 2 for Install a new server to an existing system.
5 Specify the mount point for the shared storage.

The Messenger Installation program then accesses the Messenger files that were created on the 
shared storage when the Messenger agents were installed on the preferred node. From these 
files, the Messenger Installation program lists the probable configuration for the Messenger 
agents you are installing on the current node.

6 Enter 1 for Proceed with these settings.
or
Enter 2 for Change the settings, and then modify the configuration for the Messenger agents as 
needed.

7 When asked if you want to start the agents, enter n for No.
8 Repeat Step 1 through Step 7 for each node on the Messenger failover list.

Testing Your Linux Messenger Agent Installation on Each Node
1 Test the Messenger agents by starting them as daemons, as described in “Starting the 

Messaging Agent” in the GroupWise Messenger Administration Guide.
2 Stop the Messenger agents.
3 Return to Running the Linux Messenger Installation Program on the Preferred Node for each 

node in the Messenger failover list (Messenger Clustering Worksheet item 8).

When you have installed the Messenger agents on all of the nodes in the Messenger failover list, 
continue with Changing Messenger Paths to Locations on the Messenger Partition.

Changing Messenger Paths to Locations on the Messenger 
Partition
During installation, various Messenger paths are set to locations on the node where the software is 
installed. After installation, you need to set these paths to locations on the Messenger partition, so 
that the files stored at these locations are available to the Messenger agents regardless of which 
node in the cluster the agents are running on:

 “Setting the Store Path” on page 65
 “Setting the Messaging Agent Queue Path” on page 65
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 “Setting the Archive Agent Queue Path” on page 66
 “Setting the Messaging Agent Log Path” on page 66
 “Setting the Archive Agent Log Path” on page 66

After settings these directories, continue with Configuring the Messenger Cluster Resource to Load 
and Unload the Linux Messenger Agents.

Setting the Store Path
The store path is the location where you want the archive created. During installation, the default 
store path is created in /var/opt/novell/messenger/aa/store on each node, but you need 
the archive to be stored on the Messenger partition.

1 Choose a directory where you want to store the archive and create that directory on the 
Messenger partition.

2 In the GroupWise Administration Console, navigate to Messenger > MessengerService > Objects 
> Archive Agents.

3 Click the Archive Agent object, and select the File Module tab.
4 In the Store Path field, specify your archive store path, and then click Save.

Setting the Messaging Agent Queue Path
When archiving is enabled, the Messaging Agent passes conversations to the Archive Agent when 
the conversations are completed. If the Messaging Agent cannot communicate with the Archive 
Agent when it has a conversation to archive, it saves the conversation in its holding directory (queue) 
until it can communicate with the Archive Agent again. During installation, the default Messaging 
Agent queue path is created in /var/opt/novell/messenger/ma/queue, but you need the 
queue directory to be located on the Messenger partition.

1 Choose a directory for the Messaging Agent queue and create that directory on the Messenger 
partition.

2 In the GroupWise Administration Console, navigate to Messenger > MessengerService > Objects 
> Messaging Agents.

3 Click the Messaging Agent object, and select the Agent Settings tab.
4 Click Agent > Messaging.
5 In the Messaging Preferences > Queue Path field, specify the Messaging Agent queue path, and 

then click Save.
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Setting the Archive Agent Queue Path
When the Archive Agent receives a conversation to archive, if it is already busy processing other 
conversations, it temporarily stores the conversation in its holding directory (queue). During 
installation, the default Archive Agent queue path is created in /var/opt/novell/messenger/
aa/queue, but you need the queue directory to be located on the Messenger partition.

1 Choose a directory for the Archive Agent queue and create that directory on the Messenger 
partition.

2 In the GroupWise Administration Console, navigate to Messenger > MessengerService > Objects 
> Archive Agents.

3 Click the Archive Agent object, and select the Agent Settings tab.
4 In the Archive Preferences > Queue Path field, specify the Archive Agent queue path, and then 

click Save.

Setting the Messaging Agent Log Path
During installation, the default Messaging Agent log path is created in /var/opt/novell/log/
messenger/ma, but you need the log file directory to be located on the Messenger partition.

1 Choose a directory for the Messaging Agent log files and create that directory on the Messenger 
partition.

2 In the GroupWise Administration Console, navigate to Messenger > MessengerService > Objects 
> Messaging Agents.

3 Click the Messaging Agent object, and select the Log Settings tab.
4 In the Log File Path field, specify the Messaging Agent log path, and then click Save.

Setting the Archive Agent Log Path
During installation, the default Archive Agent log path is created in /var/opt/novell/log/
messenger/aa, but you need the log file directory to be located on the Messenger partition.

1 Choose a directory for the Archive Agent queue and create that directory on the Messenger 
partition.

2 In the GroupWise Administration Console, navigate to Messenger > MessengerService > Objects 
> Archive Agents.

3 Click the Archive Agent object, and select the Log Settings tab.
4 In the Log File Path field, specify the Archive Agent log path, and then click Save.
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Configuring the Messenger Cluster Resource to Load and Unload 
the Linux Messenger Agents
The properties of the Messenger Cluster Resource object define how the Messenger partition 
functions within the cluster, how the Messenger agents are loaded and unloaded, and how failover 
and failback situations are handled.

 “Modifying the Cluster Load Script for the Linux Messenger Agents” on page 67
 “Modifying the Cluster Resource Unload Script for the Linux Messenger Agents” on page 69
 “Setting the Failover List and Policies for the Linux Messenger Agents” on page 71

Modifying the Cluster Load Script for the Linux Messenger Agents
To set up the load script in iManager:

1 Expand Clusters, and then click Cluster Options.
2 In the Cluster field, browse to the Cluster object where the Messenger cluster resource is 

located.
3 Click the Cluster object to display the cluster resources that belong to the cluster.
4 Select the Messenger cluster resource that you created when you set up the Messenger 

partition, and then click Details.
5 Click Scripts > Load Script.
6 (Conditional) If this is an NSS volume or a shared pool, use a load script similar to the following 

example, depending on the configuration of your cluster and nodes:

#!/bin/bash 
. /opt/novell/ncs/lib/ncsfuncs

# mount filesystem
exit_on_error ncpcon mount /opt="noatime,nodiratime" 
volume_name=volume_ID

# add IP address
exit_on_error add_secondary_ipaddress messenger_partition_ip_address

# start service
exit_on_error /etc/init.d/novell-nmma start
exit_on_error /etc/init.d/novell-nmaa start

# return status
exit 0
6a In the mount filesystem section, specify the volume name and volume ID of the 

Messenger partition that you are clustering (System Clustering Worksheet item 5).
6b In the add ip address section, specify the secondary IP address of the Messenger 

partition (Messenger Clustering Worksheet item 6 or Messenger Clustering Worksheet 
item 7).

6c In the start service section, provide the commands to start the Messaging Agent first, 
following by the Archive Agent.
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7 (Conditional) If this is a traditional Linux volume, use an unload script similar to the following 
example, depending on the configuration of your cluster and nodes:

#! /bin/bash
. /opt/novell/ncs/lib/ncsfunc

# define IP address
RESOURCE_IP=messenger_partition_ip_address

# define filesystem type
MOUNT_FS=filesystem

# define device (if using EVMS)
exit_on_error evms -f /var/opt/novell/ncs/ContainerActivate -rl
                                                 Share 'uname -n'
MOUNT_DEV=/dev/evms/Share/dat

# define mount point
MOUNT_POINT=/mnt/mount_point_directory

# mount file system
exit_on_error mount -t $MOUNT_FS $MOUNT_DEV $MOUNT_POINT -o 
noatime,nodiratime

# add IP address
exit_on_error add_secondary_ipaddress $RESOURCE_IP

# start service
exit_on_error /etc/init.d/novell-nmma start
exit_on_error /etc/init.d/novell-nmaa start

exit 0
7a In the define IP address section, specify the secondary IP address of the Messenger 

partition (Messenger Clustering Worksheet item 6 or Messenger Clustering Worksheet 
item 7)

7b In the define filesystem type section, specify the filesystem type that is in use on 
nodes in the cluster (System Clustering Worksheet item 5).

7c In the define mount point section, specify the mount point directory in use for the 
nodes in the cluster (System Clustering Worksheet item 5).

8 Click Apply to save the load script.
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Modifying the Cluster Resource Unload Script for the Linux Messenger 
Agents
The cluster resource unload script executes whenever the Messenger cluster resource goes offline.

1 On the iManager Cluster Resource Properties page of the Monitor Agent cluster resource, click 
Scripts > Unload Script.

2 (Conditional) If this is an NSS volume or a shared pool, use an unload script similar to the 
following example, depending on the configuration of your cluster and nodes:

#!/bin/bash
. /opt/novell/ncs/lib/ncsfuncs

# request service stop
ignore_error /etc/init.d/novell-nmma stop
ignore_error /etc/init.d/novell-nmaa stop

# stop service otherwise
sleep 8
ignore_error pkill -fx "'/etc/init.d/novell-nmma stop'"
ignore_error pkill -fx "'/etc/init.d/novell-nmaa stop'"

# delete IP address
ignore_error del_secondary_ipaddress messenger_partition_ip_address

# unmount filesystem
exit_on_error umount /mnt/mount_point_directory

# return status
exit 0
2a In the stop service otherwise section, adjust the sleep command as needed so that 

the Messenger agents can shut down normally on your system without being inadvertently 
killed by the pkill command that follows.

2b In the delete IP address section, specify the secondary IP address of the Messenger 
partition.

2c In the unmount filesystem section, specify the mount point directory in use for the 
nodes in the cluster.

2d (Conditional) If you are running the GroupWise High Availability service (gwha), stop it 
before the script stops the Messenger agents, and then start it again at the end of the 
unload script.
This prevents the GroupWise High Availability service from trying to restart the Messenger 
agents while the script is trying to stop them.
Add the following section before the request service stop section:

# Temporarily disable the gwha service under xinetd
ignore_error /sbin/chkconfig -s gwha off
ignore_error kill -HUP `pidof xinetd`
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Add the following section before the return status section:

# Restart the gwha service under xinetd
ignore_error /sbin/chkconfig -s gwha on
ignore_error kill -HUP `pidof xinetd`

3 (Conditional) If this is a traditional Linux volume, use an unload script similar to the following 
example, depending on the configuration of your cluster and nodes:

#!/bin/bash
. /opt/novell/ncs/lib/ncsfuncs

# request service stop
ignore_error /etc/init.d/novell-nmma stop
ignore_error /etc/init.d/novell-nmaa stop

# stop service otherwise
sleep 8
ignore_error pkill -fx "'/etc/init.d/novell-nmma stop'"
ignore_error pkill -fx "'/etc/init.d/novell-nmaa stop'"

# define IP address
RESOURCE_IP=messenger_partition_ip_address

# define mount point
MOUNT_POINT=/mnt/mount_point_directory

# delete IP address
ignore_error del_secondary_ipaddress $RESOURCE_IP

# umount filesystem
exit_on_error umount $MOUNT_POINT

# return status
exit 0
3a In the stop service otherwise section, adjust the sleep command as needed so that 

the Messenger agents can shut down normally on your system without being inadvertently 
killed by the pkill command that follows.

3b In the define IP address section, specify the secondary IP address of the Messenger 
partition.

3c In the define mount point section, specify the mount point directory in use for the 
nodes in the cluster.

3d (Conditional) If you are running the GroupWise High Availability service (gwha), stop it 
before the script stops the Messenger agents, and then start it again at the end of the 
unload script.
This prevents the GroupWise High Availability service from trying to restart the Messenger 
agents while the script is trying to stop them.
Add the following section before the request service stop section:

# Temporarily disable the gwha service under xinetd
ignore_error /sbin/chkconfig -s gwha off
ignore_error kill -HUP `pidof xinetd`
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Add the following section before the return status section:

# Restart the gwha service under xinetd
ignore_error /sbin/chkconfig -s gwha on
ignore_error kill -HUP `pidof xinetd`

4 Click Apply to save the unload script.

Setting the Failover List and Policies for the Linux Messenger Agents
1 On the iManager Cluster Resource Properties page of the Messenger cluster resource, click 

General.
The default policy settings are often appropriate. By default, a cluster resource:
 Fails over automatically if the node it is running on fails
 Starts automatically on the next node in its failover list
 Continues running at its failover location, even after its most preferred node is again 

available
If you are considering changing these defaults, see the OES Cluster Services for Linux 
Administration Guide for your version of OES Linux.

2 Under Preferred Nodes, arrange the nodes in the cluster into the desired failover list for the 
Messenger agents (under Messenger Clustering Worksheet item 3).

3 Click OK.

Testing Your Messenger System in a Linux Cluster
After you have configured the Messenger cluster resource, you can test the load and unload scripts 
by bringing the Messenger cluster resource online and taking it offline again.

1 In iManager, expand Clusters, and then click Cluster Manager.
2 Browse to the Cluster object to display the current cluster state.

3 (Conditional) If the new Messenger cluster resource shows Offline in the State column, click the 
new Messenger cluster resource, and then click Online.
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After a moment, the Messenger cluster resource displays Running in the State column.
4 At the server where the Messenger agents are starting, use the following commands to see that 

the Messenger agents have started:

/etc/init.d/novell-nmma status
/etc/init.d/novell-nmaa status

5 Select the new Messenger cluster resource, and then click Offline.
The State column for the Messenger cluster resource returns to Offline.

6 Use the same command that you used in Step 4 to verify that the Messenger agents have 
stopped.

7 Repeat Step 3 whenever you are ready to bring the new Messenger cluster resource online 
permanently.

8 Continue with Managing Your Messenger System in a Linux Cluster.

Managing Your Messenger System in a Linux Cluster
If the node where your Messenger system is running goes down, it fails over to the next node in its 
failover list. Messenger clients reconnect automatically as soon as the Messaging Agent restarts on 
the next node. Users who are actively carrying on conversations notice the interruption, but do not 
need to do anything to reestablish their conversation when the Messaging Agent is up and running 
again.

In comparison to failover, migration typically takes longer because the Messaging Agent 
methodically terminates its thread as part of its normal shutdown procedure.

Messenger Clustering Worksheet

Item Explanation

1) eDirectory Tree for Cluster: Record the eDirectory tree where you created the 
Cluster object when you installed OES Cluster 
Services.

For more information, see Installing OES Cluster 
Services (NCS) on Linux.

2) Cluster Name:

Master IP Address:

Record the name of the name of the Cluster object 
where your Messenger system will be located. Also 
record the master IP address of the cluster.

For more information, see Installing OES Cluster 
Services (NCS) on Linux.

3) Cluster Context: Record the full context where you created the 
Cluster object.

For more information, see Installing OES Cluster 
Services (NCS) on Linux.
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4) Nodes in Cluster

 FIle system type
 Device name
 Mount point

List the nodes that are part of the cluster that will 
include Messenger. Also list technical information, 
including file system type (reiserfs, ext3, and 
so on), device name (sda2, hda1, and so on), and 
mount point directory (/mnt, /mail, and so on) in 
use on the nodes the cluster. You need this 
information as you create load and unload scripts 
for the Messenger agents.

For more information, see Installing OES Cluster 
Services (NCS) on Linux.

5) Shared Partitions in Cluster: List the shared partitions that are available for use 
in your Messenger system.

For more information, see Installing OES Cluster 
Services (NCS) on Linux.

6) Messenger Partition for 
Messaging Agent:

Secondary IP address:

Use Same Partition for Archive 
Agent?

 Yes
 No

The Messaging Agent software is installed on each 
node in its failover list but it does use a shared 
partition to store its log files, temporary files, and 
queue directories. Specify the name of the shared 
partition in the your cluster that the Messaging 
Agent can use for these purposes. also specify the 
secondary IP address of that shared partition.

For more information, see Selecting the Messenger 
Partition and Secondary IP Address.

7) Messenger Partition for 
Archive Agent?

Secondary IP Address:

In addition to the data storage needs of the 
Messaging Agent, the Archive Agent can be 
configured to store all instant message 
conversations. It is possible that this might consume 
a large quantity of disk space. If so, you can choose 
to use a separate shared partition for the Archive 
Agent.

For more information, see Planning the Linux 
Messenger Agent Installation.

8) Failover List for Messenger 
Agents:

List other nodes in the cluster where the Messenger 
agents can fail over. You might want to have the 
same nodes on the both agents’ lists or have 
separate lists for each agent. It depends on the 
loads that each agent will be carrying.

For more information, see Determining an 
Appropriate Failover List for the Linux Messenger 
Agents.

Item Explanation
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Messenger Clustering Quick Checklist
 Plan your clustered Messenger system.

See Planning Your Messenger System in a Linux Cluster.
 Create your Messenger system and install the Messenger agents.

See Creating Your Messenger System and Installing the Linux Messenger Agents.
 In the GroupWise Administration Console, change the locations of various Messenger files from 

their default locations on local nodes to the Messenger partition that is always available no 
matter what node the Messenger agents are running on.
See Changing Messenger Paths to Locations on the Messenger Partition.

 Modify the Messenger agents cluster resource load script.
See Modifying the Cluster Load Script for the Linux Messenger Agents.

 Modify the Messenger agents cluster resource unload script.
See Modifying the Cluster Resource Unload Script for the Linux Messenger Agents.

 Set up the Messenger agents failover list and policies.
See Setting the Failover List and Policies for the Linux Messenger Agents.

 Test your clustered Messenger system.
See Testing Your Messenger System in a Linux Cluster.

9) Mount Point for Shared 
Storage:

Specify the mount point directory where the shared 
resource is mounted to the cluster node where the 
Messenger Agents run.

For more information, see Determining Cluster 
Resource Information for the Linux Messenger 
Agents.

Item Explanation
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4 4Checking GroupWise and Messenger 
Interoperability

To show Messenger presence in GroupWise, one of the following must match between GroupWise 
and Messenger:

 GroupWise DN matches Messenger DN.
 GroupWise preferred email address matches the mail attribute stored in Messenger. You can 

store the mail attribute in Messenger by doing an LDAP sync.
 GroupWise preferred email address matches the userid@defaulthostid in Messenger that 

is constructed from the user settings and their assigned policy.

NOTE: Only the users in your contact list show their presence in GroupWise. If you do not see a 
user’s presence in GroupWise, you must add them to your Messenger contact list and then restart 
the GroupWise client so that it picks up the new Messenger contact.
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III IIIOpenText Vibe

Before installing OpenText Vibe, you should thoroughly review the documentation provided at the 
Vibe documentation website. These guides provide detailed product installation and configuration 
instructions, but they do not include specific instructions for integrating OpenText Vibe with 
GroupWise. This section of the GroupWise Interoperability Guide supplies these product-specific 
instructions.

 Chapter 5, “Configuring GroupWise for Use with OpenText Vibe,” on page 79
 Chapter 6, “Accessing Your Vibe Site from the GroupWise Client,” on page 81
 Chapter 7, “Streamlining Authentication to Vibe,” on page 83
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5 5Configuring GroupWise for Use with 
OpenText Vibe

When you install OpenText Vibe with GroupWise, some configuration steps are required to integrate 
the applications.

 “Understanding How Vibe Interacts with an LDAP Directory and GroupWise” on page 79
 “Authenticating through the LDAP Directory” on page 79
 “Using GroupWise as the Vibe Email System” on page 79
 “Enabling GroupWise and Vibe Integration for GroupWise Client Users” on page 80

Understanding How Vibe Interacts with an LDAP Directory 
and GroupWise

When you install Vibe in an environment where GroupWise is already set up, the products interact 
in the following ways:

 Vibe can use an LDAP directory (NetIQ eDirectory or Microsoft Active Directory) to authenticate 
Vibe users. This means that you do not need to create Vibe users manually. Vibe can create its 
user accounts based on the users that already exist in the LDAP directory.

 Vibe can use GroupWise as its integrated email system. This means that email messages sent 
from the Vibe site are delivered to GroupWise mailboxes. It also means that GroupWise users 
can post items to Vibe folders by sending email messages to Vibe folders.

 Vibe information can be displayed in the GroupWise client. Starting in GroupWise 8.0.2, you 
can drag and drop GroupWise items into Vibe folders in the GroupWise Folder List to post items 
to the corresponding folders in your Vibe site. You can also use the GroupWise Find feature to 
search your Vibe site.

Authenticating through the LDAP Directory
For instructions, see the following sections of the Vibe 4.0.8 Installation Guide.

 “Gathering Directory Services Information”
 “Adding Users to Your Vibe Site”

Using GroupWise as the Vibe Email System
For setup instructions, see the following sections of the Vibe 4.0.8 Installation Guide:

 “Planning for Outbound Email”
 “Planning to Enable Inbound Email”
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See also the “Configuring Email Integration” section of the Vibe 4.0.8 Administration Guide:

For basic email usage instructions, see the following sections of the Vibe 4.0.8 User Guide:

 “Sending Email to Team Members and Announcing the Workspace after Its Creation”
 “Subscribing to Email Notifications from a Folder”, “Setting Up a Folder to Receive Entries Via 

Email” and “Adding Entries to a Folder Via Email”
 “Sending Email from within Vibe”

See also the following sections of the Vibe 4.0.8 Advanced User Guide:

 “Enabling Folders to Receive Entries through Email” and “Configuring Folders to Send Email 
Notifications to Other Users”

 “Sending Email Notifications”
 “Emailing Files and Attachments to the Vibe Site When You Are Over Your Quota”

Enabling GroupWise and Vibe Integration for GroupWise 
Client Users

Before you can integrate GroupWise and Vibe, your Vibe site must be set up, as described in the 
Vibe 4.0.8 Installation Guide.

1 In the GroupWise Admin console, click Domains, Post Offices, or Users, and then click the object 
where you want to make Vibe available to GroupWise client users.

2 Click Client Options > Integrations > OpenText Vibe.
3 Select Enable OpenText Vibe.
4 Provide the Vibe URL:

4a Use the following format:

https://vibe_server/ssf/ws/TeamingServiceV1
4b (Conditional) If you want to use HTTP instead of HTTPS, include it in the OpenText Vibe URL 

field, for example:

http://vibe.yourcompanyname.com
4c (Conditional) If Vibe is not configured with the default HTTPS port, include the port 

number after the hostname, for example:

vibe.yourcompanyname.com:444
4d (Conditional) If Vibe is not installed in the default location, include the path to 

TeamingServiceV1, for example:

vibe.yourcompanyname.com/Web/Vibe/TeamingServiceV1
5 Click OK.

IMPORTANT: In order for GroupWise users to take advantage of GroupWise/Vibe integration, they 
must provide their GroupWise email address in their Vibe profile.
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6 6Accessing Your Vibe Site from the 
GroupWise Client

Before you can access the Vibe site from the GroupWise client, you must add your GroupWise email 
address to your Vibe profile, as described in “Modifying Your Profile” in the Vibe 4.0.8 User Guide.

The GroupWise and Vibe Quick Start describes the Vibe functionality that becomes available in the 
GroupWise client as a result of the GroupWise/Vibe integration.
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7 7Streamlining Authentication to Vibe

You can implement single sign-on for use with OpenText Vibe, so that users do not need to log in 
separately to GroupWise and Vibe. See the following sections in “Planning an Advanced Vibe 
Installation” in the Vibe 4.0.8 Installation Guide:

 “Configuring Single Sign-On with Novell Access Manager”
 “Configuring Single Sign-On with Internet Information Services for Windows”
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IV IVOpenText Filr

Using OpenText Filr with your GroupWise system allows you to store, search, and share attachments 
in Filr. Attachments sent this way take no space in the GroupWise mailbox and are automatically 
shared in Filr. This gives you better control over you attachments and the size of your mailboxes.

IMPORTANT: Attachments sent as Filr references are considered an external resource and are not 
part of the message. If you enable Filr, GroupWise attachments stored in Filr are not archived with 
OpenText Retain.
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8 8Enabling GroupWise for Use with OpenText 
Filr

To enable the Filr integration:

 In the GroupWise Admin console, select the Domain, Post Office, or user where you want the 
Filr integration enabled.

 Go to Client Options > Integrations > OpenText Filr and select Enable OpenText Filr.
 Enter the URL for your Filr server in the following format:

https://server_ip_or_dns:port
 (Optional) Select Force storage of attachments in OpenText Filr and choose Store all attachments 

or Store attachments larger than xx MB.
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9 9Using Filr to Manage Attachments

Once Filr is enabled in your system, you can use it to store attachments. Attachments send through 
Filr are stored in a GW Attachments folder. When you send an attachment using Filr, the items are 
automatically shared with the recipients. Use the following methods to manage your GroupWise 
attachments in Filr:

 When adding attachments to an item, select Filr reference in the bottom left corner. You can 
then select a file from Filr to attach to the item.

 When adding an attachment to an item, you can right click on the attachment and select Upload 
to OpenText Filr to automatically upload it to Filr.

 If your administrator has forced attachments to be sent through Filr, using a size limit or just 
having all attachments sent through Filr, you receive a warning option upon sending an 
attachment that is not in Filr and the attachment is automatically uploaded to Filr when the 
item is sent.

 Using Find, you can select OpenText Filr and the Find searches through your Filr files as well as 
your GroupWise items.

 You can save received attachments to Filr in the File > Save menu.
 To open a Filr reference in an item, right click on the reference and select View in OpenText Filr.
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V VDe-Mail

De-Mail is an email security system available in Germany. It allows you to securely send confidential 
items electronically.
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10 10Enabling GroupWise for Use with De-Mail

To enable the De-Mail integration:

 In the GroupWise Admin console, select the Domain, Post Office, or user where you want the 
De-Mail integration enabled.

 Go to Client Options > Integrations > DE Mail and select Enable DE Mail integration.
 Select if you want to Use Mentana filtering or Use TSystem filtering.

With this enabled, users who send items to a De-Mail address are able to select additional De-Mail 
security options in the item header previous to sending the item.
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VI VIGroupWise Identity Manager Driver 
for NetIQ Identity Manager

The GroupWise Identity Manager driver for use with NetIQ Identity Manager provides data 
integration between users in NetIQ eDirectory and GroupWise accounts in your GroupWise system. 
For example, the driver can create email accounts automatically when employees are hired. The 
driver can also disable an email account when a user is no longer active. This configurable solution 
gives you the ability to increase productivity and streamline business processes by integrating 
GroupWise and eDirectory.

This guide provides information about certain administrative actions in the GroupWise Admin 
console that require you to stop the GroupWise Identity Manager driver or disable a user’s 
association.

For additional information, see:

 NetIQ Identity Manager
 Identity Manager Drivers
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11 11Identity Manager Warnings in the 
GroupWise Admin Console

Some GroupWise administrative actions in the GroupWise Admin console require that you stop the 
GroupWise Identity Manager driver or disable a user’s association with it before you perform the 
action. Most GroupWise administrative actions in the GroupWise Admin console require that you 
manually restart the GroupWise Identity Manager driver or re-enable the user’s association when 
you have completed the action, but a few do not. By default, these activities generate a warning 
message in the GroupWise Admin console:

 “Enabling Identity Manager Warnings” on page 97
 “Associating a GroupWise Object with an eDirectory Object” on page 97
 “Disassociating a GroupWise Object’s Attributes from an eDirectory Object” on page 98
 “Resolving an Invalid Association” on page 98

Enabling Identity Manager Warnings
Identity Manager warnings are disabled by default.

1 In the GroupWise Admin console, click System > System Preferences.

2 Select Display Identity Manager (DirXML) Warnings, and then click OK.

Associating a GroupWise Object with an eDirectory Object
Using the Identity Manager Management role in NetIQ iManager:

1 Stop the GroupWise Identity Manager driver.
2 Establish the association, as described in “Associating GroupWise Users with an LDAP Directory” 

in the GroupWise Administration Guide.
3 Restart the GroupWise Identity Manager driver.
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Disassociating a GroupWise Object’s Attributes from an 
eDirectory Object

In NetIQ iManager:

1 Go to the Identity Manager tab of the User object, and then disable the association with the 
GroupWise Identity Manager driver.

2 Disassociate the objects, as described in “Dissociating GroupWise Users from an LDAP 
Directory” in the GroupWise Administration Guide.

3 Go to the Identity Manager tab of the User object, and then enable the association with the 
GroupWise Identity Manager driver.

Resolving an Invalid Association
In NetIQ iManager:

1 Go to the Identity Manager tab of the User object, and then disable the association with the 
GroupWise Identity Manager driver.

2 Dissociate the user the reassociate the user, as described in “Directory Associations” in the 
GroupWise Administration Guide.
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VII VIIOpenText ZENworks

The following sections provide information about using OpenText ZENworks to distribute the 
GroupWise Client and to virtualize the GroupWise and GroupWise Messenger.

 Using ZENworks Configuration Management to Distribute the GroupWise Client
 Using ZENworks Application Virtualization for GroupWise and Messenger
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12 12Using ZENworks Configuration 
Management to Distribute the GroupWise 
Client

ZENworks Configuration Management deploys software as bundles that include all the files and 
instructions required to successfully install software on users’ workstations. You can use the bundles 
to distribute the GroupWise client to workstations.

IMPORTANT: For background information, or for help completing the ZENworks tasks outlined in the 
steps below, see “Software Distribution” in the ZENworks Configuration Management section on the 
OpenText ZENworks Documentation website.

 “Prerequisites” on page 101
 “Using ZENworks to Distribute the GroupWise Client Software” on page 102

Prerequisites
Before creating a bundle for the GroupWise client software in ZENworks, you must have the 
following:

 A copy of the following GroupWise client software on the machine where you are creating the 
ZENworks Bundle:
 extract_setupip_packs.cmd
 setupip.fil
 setupip.xx (where xx is a two-letter language code)

The GroupWise client software can be found on the GroupWise server in the following location:

You can also extract the GroupWise Server installation files on your workstation if you don’t 
have access to the GroupWise server. To do this, follow the steps in “Extracting the GroupWise 
Software” in the GroupWise Administration Guide.

 A GroupWise MST file to customize the GroupWise install. For information on creating an MST 
file, see “Using GroupWise Client Custom Installation Options” in the GroupWise 
Administration Guide.

IMPORTANT: If you want a shortcut created on the desktop for GroupWise, make sure that is 
selected in the MST file.

Linux:
Windows:

/opt/novell/groupwise/agents/data/client/setup/win32
C:\Program Files\Novell\GroupWise 
Server\agents\data\client\setup\win32
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 (Optional) A copy of the GroupWise icon which can be found on your GroupWise server in the 
following location:

\groupwise_software_path\client\win32\groupwise.ico

Using ZENworks to Distribute the GroupWise Client 
Software

There are two bundles you can create to distribute the GroupWise client software. The first assumes 
that GroupWise is not installed on the target machines. The second lets the user know that 
GroupWise is being installed and prompts them to close it if it is open.

 “Creating a Bundle to Install the GroupWise Client” on page 102
 “Creating a Bundle to Install/Upgrade the GroupWise Client” on page 104

Creating a Bundle to Install the GroupWise Client
Use this bundle if your workstations do not have the GroupWise client installed.

1 In the ZENworks Control Center, on the Bundles tab, create a new Windows Empty Bundle with 
the following:
 Upload the GroupWise icon as the icon for the bundle. The icon can be found on the 

GroupWise server in the following location:
\groupwise_software_path\client\win32\groupwise.ico

 Select Create as Sandbox and make sure Define Additional Properties is selected when you 
finish the bundle.

2 Create the following actions on the Install tab of the bundle:
2a An Install Files action called Install GroupWise Installation Files that does the 

following:
 Add the following three files:

 extract_setupip_packs.cmd
 setupip.fil
 setupip.xx (where xx is a two-letter language code)

 Select Do not compress or encrypt uploaded content if it is available.
 Set the Destination Directory to a temporary location on the machine where all of the 

GroupWise install actions can be performed. For example:
C:\Windows\Temp\gwclient\

 Under Executable security level, select Run as secure system user (Don’t allow system to 
interact with desktop).

2b A Launch Executable action called Run extract_setupip_packs.cmd that does the 
following:
 In the Command field, specify the path to the extract_setupip_packs.cmd file 

which was placed on the device in Step 2a. For example:
C:\Windows\Temp\gwclient\extract_setupip_packs.cmd
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 In the Working Directory field, specify the temporary location specified in Step 2a. For 
example:

C:\Windows\Temp\gwclient\
 In the Wait before proceeding to next action box, select When action is complete.
 On the Advanced tab, make sure Run as secure system user (Don’t allow system to 

interact with desktop) is selected.

NOTE: When this step runs on the device, a win32 folder is created in the temporary folder 
where the GroupWise client install files were placed previously. You need to know the path 
to this folder for the following steps.

2c An Install File(s) action called Install groupwise.mst that does the following:
 Add the groupwise.mst file.
 Select Do not compress or encrypt uploaded content if it is available.
 Set the Destination Directory to be the path to the win32 folder that gets created by 

the script in Step 2b. For example:
C:\Windows\Temp\gwclient\win32

 Under Executable security level, select Run as secure system user (Don’t allow system to 
interact with desktop).

2d A Run Script action called Run install.bat that does the following:
 Select Define your own script.
 Edit the script content and specify the following:

SET GW_INST_REMOVE_MSI=True
SET GW_INST_TRANSFORM_FILE=groupwise.mst
C:\Windows\Temp\gwclient\win32\install.bat /silent
The install.bat can take one of the two following parameters:

 In Wait before proceeding to next action, select When action is complete.
 On the Advanced tab under Executable Security, select Run as secure system user (Do 

not allow system to interact with desktop).
2e A Launch Executable action called Launch GroupWise that does the following:

 For Command, specify the following:

"C:\Program Files (x86)\Novell\GroupWise\grpwise.exe"

NOTE: Change this path accordingly if GroupWise was installed to a different location.

Parameter Description

/unattended Users see a window showing that GroupWise 
is being installed, but do not have to interact 
with the install.

/silent Users do not see that GroupWise is being 
installed.
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2f A Create/Delete Directory action called Delete Temporary Install Files that does 
the following:
 For Action Type, select Delete directory.
 For Directory Name, specify C:\Windows\Temp\gwclient or the temporary 

location from Step 2a.
 Under Executable security level, select Run as secure system user (Do not allow system 

to interact with desktop).
3 The bundle is now configured to install the GroupWise client. Assign the bundle to a test 

workstation to test it and make sure it is working as desired before publishing the bundle.

Creating a Bundle to Install/Upgrade the GroupWise Client
Use this bundle if your workstations have the GroupWise Client installed.

1 In the ZENworks Control Center, on the Bundles tab, create a new Windows Empty Bundle with 
the following:
 Upload the GroupWise icon as the icon for the bundle. The icon can be found on the 

GroupWise server in the following location:
\groupwise_software_path\client\win32\groupwise.ico

 Select Create as Sandbox and make sure Define Additional Properties is selected when you 
finish the bundle.

2 Create the following actions on the Install tab of the bundle:
2a A Prompt User action called Prompt User to close GroupWise that does the 

following:
 Select the desired values for User Cancels Allowed and Seconds to be Displayed.
 Define prompts for desired locales.
 Add prompt text similar to the following:

GroupWise is ready to be installed/upgraded. Please save any 
work-in-progress emails, close all GroupWise windows, and click 
OK.

2b A Run Script action called Check for Running GroupWise that does the following:
 Select Define your own script.
 Edit the script content and add the following:

SETLOCAL EnableExtensions
set EXE=grpwise.exe
FOR /F %%x IN ('tasklist /NH /FI "IMAGENAME eq %EXE%"') DO IF %%x 
== %EXE% goto FOUND
EXIT 0
goto FIN
:FOUND
GroupWiseStillRunning
:FIN
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 In Wait before proceeding to the next action, select When action is complete.
 On the Advanced tab under Executable security level, select Run as secure system user 

(Don’t allow system to interact with desktop).
2c An Install Files action called Install GroupWise Installation Files that does the 

following:
 Add the following three files:

 extract_setupip_packs.cmd
 setupip.fil
 setupip.xx (where xx is a two-letter language code)

 Select Do not compress or encrypt uploaded content if it is available.
 Set the Destination Directory to a temporary location on the machine where all of the 

GroupWise install actions can be performed. For example:
C:\Windows\Temp\gwclient\

 Under Executable security level, select Run as secure system user (Don’t allow system to 
interact with desktop).

2d A Launch Executable action called Run extract_setupip_packs.cmd that does the 
following:
 In the Command field, specify the path to the extract_setupip_packs.cmd file 

which was placed on the device in Step 2c. For example:
C:\Windows\Temp\gwclient\extract_setupip_packs.cmd

 In the Working Directory field, specify the temporary location specified in Step 2c. For 
example:

C:\Windows\Temp\gwclient\
 In the Wait before proceeding to next action box, select When action is complete.
 On the Advanced tab, make sure Run as secure system user (Don’t allow system to 

interact with desktop) is selected.

NOTE: When this step runs on the device, a win32 folder is created in the temporary folder 
where the GroupWise client install files were placed previously. You need to know the path 
to this folder for the following steps.

2e An Install File(s) action called Install groupwise.mst that does the following:
 Add the groupwise.mst file.
 Select Do not compress or encrypt uploaded content if it is available.
 Set the Destination Directory to be the path to the win32 folder that gets created by 

the script in Step 2d. For example:
C:\Windows\Temp\gwclient\win32

 Under Executable security level, select Run as secure system user (Don’t allow system to 
interact with desktop).
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2f Do the following:
 Select the check box next to the Check for Running GroupWise Run Script action 

that was created in Step 2b.
 Click Duplicate to add another copy of this action.

This is a check to make sure the user hasn’t launched GroupWise after the initial prompt.
2g A File Removal action called Delete GroupWise Shortcut that does the following:

 For Full Path to Source Files/Directories, specify the following:

${public}\Desktop\GroupWise.lnk
 For Run Action As, make sure System is selected.

2h (Optional) A Display Message action called Alert User that GroupWise install is 
finishing that does the following:
 Define prompts for the desired locales. The message could be similar to the following:

GroupWise will finish it's install/upgrade in a few minutes. The 
application will launch automatically when finished.
Thank you for your patience!

2i A Run Script action called Run install.bat that does the following:
 Select Define your own script.
 Edit the script content and specify the following:

SET GW_INST_REMOVE_MSI=True
SET GW_INST_TRANSFORM_FILE=groupwise.mst
C:\Windows\Temp\gwclient\win32\install.bat /silent
The install.bat can take one of the two following parameters:

 In Wait before proceeding to next action, select When action is complete.
 On the Advanced tab under Executable Security, select Run as secure system user (Do 

not allow system to interact with desktop).
2j A Launch Executable action called Launch GroupWise that does the following:

 For Command, specify the following:

"C:\Program Files (x86)\Novell\GroupWise\grpwise.exe"

NOTE: Change this path accordingly if GroupWise was installed to a different location.

Parameter Description

/unattended Users see a window showing that GroupWise 
is being installed, but do not have to interact 
with the install.

/silent Users do not see that GroupWise is being 
installed.
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2k A Create/Delete Directory action called Delete Temporary Install Files that does 
the following:
 For Action Type, select Delete directory.
 For Directory Name, specify C:\Windows\Temp\gwclient or the temporary 

location from Step 2c.
 Under Executable security level, select Run as secure system user (Do not allow system 

to interact with desktop).
3 The bundle is now configured to install the GroupWise client. Assign the bundle to a test 

workstation to test it and make sure it is working as desired before publishing the bundle.
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13 13Using ZENworks Application Virtualization 
for GroupWise and Messenger

OpenText ZENworks Application Virtualization lets you convert applications that run on Microsoft 
Windows into self-contained virtual applications. After being virtualized, an application becomes a 
single, isolated file that runs instantly from anywhere, including a thumb drive or other removable 
media. Unlike traditional installation methods, the single virtual application file does not require a 
separate setup process, and does not rely on external components and runtimes, reboots, or 
administrative privileges. After virtualization, the application is isolated from other system 
applications, preventing DLL conflicts and other deployment nightmares, yet the experience for the 
application’s user is unchanged.

For instructions on virtualizing the GroupWise client, see “Preparing GroupWise and GroupWise 
Notify for Virtualization” in the ZENworks Integration and Streaming Guide (https://
www.novell.com/documentation/zav11/).

For instructions on virtualizing the Messenger client, see “Preparing Novell Messenger for 
Virtualization” in the ZENworks Integration and Streaming Guide (https://www.novell.com/
documentation/zav11/).
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VIII VIIIMobile Devices

Information about GroupWise interoperability with mobile devices is included in the next section: 
Interoperability with Mobile Devices.
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14 14Interoperability with Mobile Devices

The GroupWise Mobility Service provides data synchronization between GroupWise mailboxes and 
mobile devices for synchronizing email, appointments, contacts, tasks, notes, and phone messages. 
The GroupWise Mobility Service is fast, reliable and scalable, and supports the latest device 
operating systems. For more information, see the GroupWise Mobility Documentation website.

To support BlackBerry devices with an operating system earlier than BlackBerry 10.x, use BlackBerry 
Enterprise Server for GroupWise.
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IX IXTeamWorks

IMPORTANT: Support for integrating OpenText TeamWorks with GroupWise ended in GroupWise 
version 18.3. The content below is only applicable to GroupWise 18.2.1 and earlier versions.

TeamWorks helps you easily collaborate via your web browser, mobile device, or the GroupWise 
client. With TeamWorks, you can discuss ideas, post files, share links, and invite others to join the 
conversation in virtual discussion rooms.

GroupWise is the desktop client for TeamWorks. Your TeamWorks server information is added to the 
GroupWise Administration Console by your administrator. Once that is done, you can login to 
TeamWorks while in GroupWise and see the TeamWorks folders in the folder list. From within a 
room you can read, add new content, or edit content created by you.

 Chapter 15, “Enabling GroupWise for Use with TeamWorks,” on page 117
 Chapter 16, “Using TeamWorks in the GroupWise Client,” on page 119
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15 15Enabling GroupWise for Use with 
TeamWorks

IMPORTANT: Support for integrating OpenText TeamWorks with GroupWise ended in GroupWise 
version 18.3. The content below is only applicable to GroupWise 18.2.1 and earlier versions.

To enable the TeamWorks integration:

 In the GroupWise Administration console, select the Domain, Post Office, or user where you 
want the TeamWorks integration enabled.

 Go to Client Options > Integrations > TeamWorks and select Enable OpenText TeamWorks.
 Specify the TeamWorks URL and port number in the following format:

https://<teamworks_server>:<port>
Users are now able to login to TeamWorks in the GroupWise Client
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16 16Using TeamWorks in the GroupWise Client

IMPORTANT: Support for integrating OpenText TeamWorks with GroupWise ended in GroupWise 
version 18.3. The content below is only applicable to GroupWise 18.2.1 and earlier versions.

Once your administrator has configured TeamWorks in the GroupWise Admin Console, you can use it 
to collaborate with your teams and groups.

IMPORTANT: In this release of GroupWise, you cannot create TeamWorks Rooms or Topics in the 
GroupWise client. They must be created in TeamWorks first before you can use them in the 
GroupWise Client.

You can create a comment to a topic by opening it in the room list and typing in the Reply box at the 
bottom of the Topic. Comments and topics that you have created can be edited or deleted.
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